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1.0 Introduction 

DRIFT is an advanced gas dispersion model.  DRIFT was originally developed to 
model dense gas dispersion from instantaneous or continuous releases.  DRIFT 
Version 3 is a new computer implementation of the model containing a number of 
major model enhancements including: 

• Buoyant lift-off and rise 

• A fully integrated jet model 

• Multi-component mixtures 

• Finite duration and time-varying releases 

Some of the above enhancements were driven by the requirements of modelling 
hydrogen fluoride dispersion in moist atmospheres under conditions where buoyant 
lift-off is predicted.  Other enhancements were driven by the desire to cover a wider 
range of release scenarios within a single model. 

Given the above enhancements to DRIFT, the original model acronym basis of 
‘Dense Releases Involving Flammables or Toxics’ should perhaps be replaced by a 
more general one: ‘Dispersion of Releases Involving Flammables or Toxics’. 

This DRIFT User Guide is structured as follows: 

• Installation instructions and an overview of the user interface are given in 
section 2.0.  

• Model input is described in section 3.0.  

• Running the model and extracting results is described in section 4.0.  
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2.0 Getting Started 

2.1 Installation 

Download the latest version of software using the supplied URL and password.   
 
There is a choice of two installers: DRIFTSetup64.msi installs the 64-bit version of 
DRIFT and DRIFTSetup32.msi installs the 32-bit version.  Either version can run on 
64-bit Windows 10.  The main consideration of which version to install is dependent 
upon whether DRIFT’s Component Object Model (COM) interface is going to be used 
to automate running of DRIFT or obtaining results.  DRIFT’s COM interface can be 
used in suitable COM enabled software e.g., Microsoft Excel.  To use DRIFT’s COM 
interface, the bitness of the installed DRIFT must match that of the COM client.  For 
example, if 32-bit Microsoft Office is installed then 32-bit DRIFT should be installed, 
conversely if 64-bit Microsoft Office is installed then 64-bit DRIFT should be installed.  
If the COM interface is not used, then it is recommended to install 64-bit DRIFT on 
64-bit Windows.  Administrator privileges will be required whilst installing DRIFT. 
 
If an earlier version of DRIFT is already installed, then it is recommended that this is 
uninstalled first.  Double click on DRIFTSetup64.msi or DRIFTSetup32.msi to install 
DRIFT. 
 
DRIFT installs a shortcut on the Windows desktop as shown in Figure 2-1 below. 
 

 
Figure 2-1 DRIFT desktop shortcut 

 
DRIFT also installs on the Windows menu under ESR Technology.  DRIFT can be 
run by clicking on either the Windows menu or the desktop shortcut. 
 
When opening, DRIFT checks for the presence of a valid licence.  If no valid licence 
is found, then a dialogue box as shown in Figure 2-2 is displayed.  The installation ID 
is unique to the computer on which DRIFT is installed.  Note that running on a 
different computer will generate a different installation ID and requires a new licence 
to be provided. 
 

 
Figure 2-2 Dialogue box when no valid licence is found 

 



 6 

To obtain a valid licence please email softwaresupport@esrtechnology.com with the 
installation ID.  You can press the “Close DRIFT” button to close DRIFT whilst 
waiting for a valid licence.  Subject to entitlement to a valid licence, a licence file will 
be emailed back to the sender.  If you previously closed DRIFT, run DRIFT again and 
this time press the “Enter licence key” button on the ‘No valid licence’ dialogue box 
which presents the “Enter licence” dialogue box shown in Figure 2-3.  Drag and drop 
the supplied licence file into the space provided and press the “Confirm” button. 
 

 
Figure 2-3 Enter licence dialogue box 

 
When a valid licence is detected, DRIFT’s user interface will open as illustrated in 
Figure 2-4. 
 

 
Figure 2-4  DRIFT user interface 

mailto:softwaresupport@esrtechnology.com
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2.2 Setting the Substance Properties Data Source 

DRIFT can obtain substance properties data from three different sources: 
 

1. The ESR substance properties database supplied with the model. 
2. HSE Substance Property Information (SPI) files located in a specified folder. 
3. From user input substance properties data entered and stored on a per run 

basis. 
 
The ESR substance properties database is the default.  This takes the form of a 
Microsoft Access .mdb file, which is installed in the same folder as the DRIFT 
executable (on 64-bit windows this is generally C:/Program Files/ESR 
Technology/DRIFT/ESRSubstance.mdb, on 32-bit Windows it is generally 
C:/Program Files (x86)/ESR Technology/DRIFT/ESRSubstance.mdb).  Microsoft 
Access does not need to be installed for DRIFT to be able connect to this database. 
The ESR substance properties database is a port of the SRD Databank substance 
properties data as used by earlier versions of DRIFT.  The ESR substance properties 
database always needs to be present since DRIFT obtains ‘standard’ substance 
properties data from this for air and water, also it supports importing and running 
DRIFT from legacy (old DRIFT and EJECT) files. 
 
HSE SPI Files are in a format specific to the UK Health and Safety Executive (HSE) 
and these are not generally available outside of HSE. To make use of HSE SPI files, 
all the .spi files must all be collated in one folder placed either locally on a user’s 
machine or on a shared network drive. 
 
Once DRIFT is open, the substance properties data source can be set via the 
Settings->Substance Data Source... menu item which displays the dialogue box 
shown in Figure 2-5. 
 

 
Figure 2-5 Selecting the Substance Properties Data Source 

 
  
Select either SPI Files or ESR Substance as the default data source.  Generally, 
within HSE it is envisaged that SPI files shall be used, whereas elsewhere ESR 
Substance shall be used. 
 
The file locations are specified below.  In the case of SPI files this is the folder where 
the SPI files are located.   
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User input of substance properties data defined on a per run basis is described in 
Section 3.7. 
 

2.3 Main Window 

When DRIFT is first launched the user is presented with a main window containing a 
new DRIFT document ready for input. The main window is shown in Figure 2-6. 

 

Figure 2-6 DRIFT Main Window. 
 

Menu commands (actions) in DRIFT can be accessed via the menu bar located at 
the top of the window. The most commonly used actions can also be accessed 
through the toolbar, which is located just below the menu bar. 

At the bottom of the window is a status bar that provides feedback on the program 
status (e.g. if the model is running or not). Hovering the mouse pointer over a menu 
button or field/ field heading will provide a brief description of the field. 

The central portion of the main window is divided into three major sections as 
outlined below. Further information on each can be found in the sections referenced 
below. 

• Scenario Input  

Described in section 3.0, the input window is located at the left-hand side of 
the main window and is used to specify the inputs for the scenario to be 
modelled.  The input window is arranged into tabbed pages. Most of the 
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inputs for a scenario can be entered using the controls on these tabbed 
pages. The tabbed pages are ordered so that when defining a new scenario, 
tabs are most conveniently filled in order from the left-most to the right-most 
tab. The right-most tab defines the toxic and flammable target levels that are 
required to be modelled.  

• Graphical and Tabular Output  

Described in section 4.3, graphical and tabular output is displayed on the 
right-hand side of the main window. Upon completion of a scenario run, 
DRIFT displays default plan view contour plots for the requested flammable 
and toxic target levels.  Controls on these plots allow different views to be 
obtained, e.g., contour plots in plan view and elevation, centreline variation, 
hazard range summary and tabular results.  Additionally custom centreline 

plots and tables can be created using the  button, or deleted using the  
button. The outputs are cleared if any of the scenario inputs are changed. 

• Message Window  

Below the graphs and tables is the message window. This window provides 
important feedback on how the model is running and any problems that the 
model encounters. Any messages that appear here during a run are saved 
with the document and can be viewed when the document is loaded at a later 
date. 

 

output.html
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2.4 Loading and Saving Documents 

To save a document, use the File→Save menu item, press Ctrl + S, or click on 

the  toolbar button. If the document has been saved previously, then DRIFT will re-
use this filename.  Otherwise, if this is the first time that this document has been 
saved, DRIFT will show a standard save file dialog asking for a filename to save the 
document to.  If the open document has a filename it is displayed in DRIFT’s title bar. 
The scenario inputs, output specification, run-time messages, and results are all 
stored in a single file with a .drift extension. DRIFT documents contain all of the 
information necessary to modify or run a model at a later date, and they can be 
saved at any time, apart from when the scenario is being run. 

An existing document can be loaded by using the File→Open... menu item, pressing 

Ctrl + O, or by clicking on the  toolbar button. This will open a standard file dialog 
where you may select an existing file or cancel the operation.  In addition to .drift 
files, DRIFT allows legacy file types from previous versions of DRIFT (.din) and files 
generated by Panache (.pan) to be loaded.  Note, DRIFT only reads the input data 
from legacy files so that these scenarios may be re-run using the new version of 
DRIFT and, if desired, saved as a new .drift file. Also note that if DRIFT is given a 
.din file that specifies the Isothermal thermodynamic option (see DRIFT v2 
documentation) with a user defined substance then the user may be required to 
manually enter the vapour specific heat capacity for the substance before the model 
will run. This is because the Isothermal thermodynamic option is incompatible with 
the use of atmospheric profiles in DRIFT and is accordingly not supported. 

In the circumstance that the user wishes to simulate dispersion using the input data 
from an existing Panache (EJECT) jet run then only the Panache (.pan) file should be 
loaded rather than loading from the accompanying .din file. 

DRIFT also supports a "recently used files" list that can be used to immediately open 
a recently used .drift, .din or .pan files. This list is updated each time a document is 

opened or saved and is accessed by the File→Open Recent menu item. 

DRIFT supports long filenames throughout and, on a per user basis, it will remember 
the last directory that you accessed files from in between sessions, saving you 
having to navigate to the same directory each time. 

.drift files are plain text XML (eXtensible Markup Language) documents that may be 
edited with any text editor.  However, use of a text editor to edit DRIFT documents is 
not recommended as it requires a detailed knowledge of the keywords used the 
model and the dependencies between them.  Also, editing files this way has the 
potential to corrupt the encoded output data which is also stored in the files.  
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2.5 Online Help 

There are three options to obtaining online help whilst using DRIFT: 
 

1. Tool-tips 
2. What’s this?  
3. Online User Manual 
 

2.5.1 Tool-tips 

Tool-tips can be accessed either by hovering the mouse pointer over a user input 
name for a couple of seconds until a short description is displayed in a yellow text 
ribbon.  
 

2.5.2 What’s this? 

What’s this help is intended to provide a more detailed help than given by a tool-tip.  

What’s this help is obtained by either selecting the  button on the tool bar, What’s 
this? from the Help menu, or Ctrl+F1.  Clicking on the object of interest with the 
mouse pointer will display the What’s this description. 
 

2.5.3 Online User Manual 

The online user manual is an electronic version of this User Guide.  It is available 

through the Help→DRIFT User Manual… menu item, pressing the  button, or 
pressing F1. 
 

2.5.4  About DRIFT 

The Help→About DRIFT… menu brings up an About dialogue box which displays 
the version number for DRIFT along with licensing and copyright information. 
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3.0 Scenario Input 

The main scenario input for DRIFT is through the input tabs on the left-hand side of 
the main window. Optional scenario inputs relating to Ground Transfer, changing the 
default Termination Conditions and specifying Obstacles are located on the Scenario 
menu.  
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3.1 Description Tab 

The description tab, shown in Figure 3-1, provides a means for assigning a reference 
number or title to a model for QA purposes in addition to the filename. There is also a 
text input box that may be used to store a longer description of the run and any other 
information that may be relevant to the model. Both the title/reference number and 
the entire description are included in the report when the document is printed or 
exported to HTML. 

 

Figure 3-1 Description Tab 
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3.2 Release Tab 

The release tab, shown in Figure 3-2, is used to tell DRIFT about the conditions of 
the release, as well as any other associated information. The tab is split under a 
variety of subheadings which are described below. 

  
Figure 3-2 Release Tab 

 

3.2.1 Type 

The following release types are available: 

• Instantaneous 

An instantaneously released cloud, or cloud of very short release duration 
compared to the travel time to the target receptor location.  Catastrophic 
failure of a pressure vessel containing gas or superheated liquid (i.e., stored 
above its normal boiling temperature) is an example of an instantaneous 
release. 

• Steady Continuous 

A plume formed from continuous release at a steady release rate. The steady 
continuous model neglects along-wind diffusion and a represents a release of 
duration much longer than the travel time to the target receptor. A release 
from a large inventory through a small hole is an example of a release that 
might be approximated as being steady continuous. 
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• Finite Duration 

A steady release which stops after a finite time. The finite duration model 
includes along-wind diffusion.  In the limit of a long duration, the finite duration 
model approximates the steady continuous case and for a short duration 
release it approximates the instantaneous case.  Generally, this results in a 
finite duration release giving results similar to a steady continuous release in 
the near field and being capped by the release mass in the far field, which 
would otherwise be over-predicted by a steady continuous model. A steady 
release that is terminated e.g. by closing a valve is an example of a release 
that might be approximated as being finite duration. 

• Time Varying 

In the circumstance where the dispersing cloud cannot be considered to be 
steady over the release time, or instantaneously released, then time varying 
option may be selected.  For the time varying option the release rate as a 
function of time must be provided by the user – the release rate at up to 100 
steps may be entered.  DRIFT approximates the input release rate profile into 
a generally smaller number of finite duration segments.  When DRIFT is run, 
the results from the segments are combined to give a time varying dispersing 
cloud.  The time varying model includes along wind-dispersion in each 
segment. A decaying release rate due to inventory depressurisation is an 
example of a scenario that might be approximated by the time varying model. 
The time varying model is also used by DRIFT when importing a vaporising 
pool source term from a GASP file – in this case the release rate profile is 
taken directly from the GASP results (see Section 3.11). 

Some of the subsequent inputs differ depending on which release type is selected. 
The controls on the input tabs automatically change to reflect this dependency. 

3.2.2 Phase 

Here the user specifies the phase of the release material.  
 

• Gaseous 
 

This option specifies that the released material is initially entirely in the vapour 
phase.  Specifying this option does not preclude subsequent condensation of 
liquid in the cloud if DRIFT determines conditions imply this. Using this option 
DRIFT will always assume that the release is initially pure vapour, even in the 
circumstance that the release temperature is below the release substance 
boiling point. An example of a gaseous release is methane gas released from 
pressurised storage. 

 

• Superheated Liquid / Two-Phase 
 

This option allows liquid to be initially present in the release.  If the liquid is 
superheated (i.e., above its normal boiling temperature) then at runtime 
DRIFT will perform a flash calculation to determine the conditions at 
atmospheric pressure.  An example of a superheated liquid release is the 
release of pressure liquefied propane. 
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This option also covers the modelling of sub-cooled liquid (i.e., below it 
normal boiling point) as a spray.  DRIFT assumes that liquid is present in the 
cloud as small drops at the same temperature as the vapour in the cloud.  An 
example of a sub-cooled liquid spray is a pressurised release of toluene 
diisocyanate (TDI) at ambient temperature. 
 
When modelling sub-cooled liquid releases and liquid releases with low 
superheat consideration should be given to removal of liquid by deposition, 
either directly near the source by specifying the Rainout Fraction or 

continuously during dispersion using the Scenario→Ground Transfer→Liquid 
Deposition menu Option.  

When the Gaseous option is selected then only the substance, substance 
temperature, initial dilution and release rate can be changed by the user. If the 
Superheated Liquid / Two-phase option is selected then the Pressure, Liquid Fraction 
and the Rainout Fraction of the release material can also be entered by the user. 

3.2.3 Substance 

The Substance combo box allows the user to select the release substance they wish 
to model from a list of substances in the substance data source (either ESR 
Substance Database or HSE SPI Files).  Alternatively, the user has the option of 
defining a new single-component release substance or specifying a multi-component 
mixture of substances by clicking on the Define button to the right of the combo box 
(see Section 3.7). All contaminant substances entered in this way are assumed to be 
immiscible with water – it is possible to enter a substance that is miscible (e.g. forms 
an ideal solution) with water by using the mixture editor (see Section 3.6.2). 

 

3.2.4 Temperature 

The stagnation temperature of the release in Kelvins.  
 
In most cases the release temperature can be taken to be equal to the storage or 
reservoir temperature of the released fluid. 
 
If the input temperature implies a superheated liquid release, then DRIFT will do a 
flash calculation to determine the conditions after flashing (neglecting air entrainment 
during this process). 
 
If the input implies a sub-cooled liquid release (liquid spray) then DRIFT will run 
under the assumption that the release is broken up into a fine airborne spray. 
Efficient liquid break-up requires high pressure through a small/sharp edged orifice - 
this is considered unlikely for an instantaneous release. In this circumstance DRIFT 
will not run but produce a warning message. 
 
If the input implies a sub-cooled vapour (i.e., a condensable vapour below its 
saturation temperature) then DRIFT may condense some gas as liquid. However, 
this is based on the initial enthalpy of the release being that of the gas.  
 
If source conditions have been estimated using another model, e.g., using a two-
phase release rate model then the input temperature should match the output from 
the model.  For example, if the output is choked flow conditions (vapour fraction, 
temperature, pressure) at the exit then the temperature, pressure and liquid fraction 
should be entered to match. 
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If the Superheated Liquid / Two Phase option is selected, then the Sat Temp. button 
becomes available. Pressing the Sat Temp. button sets the temperature to be the 
saturation temperature of the substance at the specified exit pressure (see 
Pressure). 
 

3.2.5 Pressure 

The absolute pressure of the release in Pascals. 
 
The release pressure is not required as an input for gaseous releases since in this 
circumstance the pressure is calculated by the model. 
 
The pressure to be input from DRIFT corresponds to the assumed pressure at the 
exit and is not necessarily equal to the storage or reservoir pressure.  Guidance is 
given below: 
 
In the case of unchoked flow the release pressure can be taken to be atmospheric 
pressure.  
 
In the case of choked flow the release pressure can be taken to be the choke 
pressure. 
 
In the case of a superheated liquid release through a hole in vessel wall then there 
may be insufficient time for flashing and the release may be approximated as an 
unchoked liquid release 
 
If source conditions have been estimated using another model, e.g., using a two-
phase release rate model then the input pressure should match the output from the 
model.  For example, if the output is choked flow conditions (vapour fraction, 
temperature, pressure) at the exit then the temperature, pressure and liquid fraction 
should be entered to match.  
 
The main influence of pressure is in determining the momentum of jet releases. 
 
Pressing the SVP button sets the exit pressure to be the saturated vapour pressure 
at the specified release temperature (see Temperature). 
 

3.2.6 Liquid Fraction 

Fraction of the release that is liquid at the exit. Strictly this input is a mole fraction. In 
the case of pure single component substance releases, the mole fraction equals the 
mass fraction. In the case of multi-component releases, the liquid fraction is input for 
each component in a separate dialogue box. 
 
A liquid fraction of 1 indicates a pure liquid release and 0 a pure vapour release.  
DRIFT will do a flash calculation for superheated liquid releases.  DRIFT will model 
sub-cooled liquid releases as an airborne spray (except for a sub-cooled 
instantaneous liquid release in which case complete break-up to small drops is less 
likely) 
 
If source conditions have been estimated using another model, e.g., using a two-
phase release rate model then the input liquid fraction should match the output from 
the model.  For example, if the output is choked flow conditions (vapour fraction, 
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temperature, pressure) at the exit then the temperature, pressure and liquid fraction 
should be entered to match. 

3.2.7 Rainout Fraction 

The fraction of the release liquid mass after flashing that is assumed to rainout as 
liquid drops at the source.  The rainout liquid is assumed to be directly deposited on 
the ground at the source and does not contribute further to the atmospheric 
dispersion, i.e., no vaporisation of rained out material is accounted for in the model.  
In addition to immediate rainout, it is possible to specify continuous liquid deposition 
based upon drop size (see Section 3.8). 
 

3.2.8 Contaminant Mass Fraction 

The mass fraction of contaminant at the source.   A value of 1 specifies that the 
release is 'pure contaminant' i.e., consists only of the specified release substance. 
When the value is less than 1, the remaining fraction of the release is made up of 
ambient moist air.  In the circumstance that another model has been run prior to 
DRIFT to predict dilution due to the source term, e.g., dilution during catastrophic 
failure of a pressure vessel, then the mass fraction implied by this dilution should be 
input. 
 

3.2.9 Contaminant Mass [Instantaneous] 

The initial mass of contaminant (in kilograms) in the instantaneously released cloud.  
Note this mass excludes any moist air that is specified using a contaminant mass 
fraction less than 1. 
 

3.2.10 Stationary Initial Cloud [Instantaneous] 

The default for an instantaneous release which initially has no moist air mixed in 
(contaminant mass fraction equal one) is that the cloud centroid starts from rest.  
Alternatively, if the cloud initially consists of a mixture of contaminant and moist air 
(contaminant mass fraction less than one) then a non-zero velocity is calculated 
associated with entraining momentum from the air that is initially present.  This is 
intended to represent the conditions after entrainment of air from the atmosphere, 
e.g., due to momentum driven turbulent growth after catastrophic failure of a 
pressure vessel.  To force the cloud to initially be at rest check the Stationary Initial 
Cloud checkbox to ensure that starts from rest – useful for validation (e.g., Thorney 
Island instantaneous trials).  
    

3.2.11 Release Rate [Steady Continuous, Finite Duration] 

The release rate of contaminant in kilograms per second.  Note this rate excludes 
any moist air that is specified using a contaminant mass fraction less than 1. 
 

3.2.12 Release Duration [Steady Continuous, Finite Duration] 

The duration of the release in seconds.  In the case of a steady continuous release 
this simply determines the exposure duration for the release. The exposure duration 
may also be capped by the maximum exposure duration on the targets tab (see 
Section 3.5.1).  For a finite duration release this also affects the rate of dilution due to 
the inclusion of along-wind diffusion at the front and back of the cloud. 
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3.2.13 Time Varying Release Rate Profile [Time Varying] 

When the Time Varying release type is selected the Release Tab changes to that 
shown in Figure 3-3.  This gives the user the option to enter a time varying release 
rate profile in up to 100 rows.  The first column is the time (in seconds) from start of 
the release and the second column is the release rate at that time (in kilograms per 
second).  The release rate profile should be ordered with increasing time and the 
release rate should be single valued in time (i.e., not have multiple values at the 
same time). 
 

 
Figure 3-3 Release Tab for Time Varying Release 

 

 
Pressing the Recalculate button (re-)calculates the total mass released from the input 
release rate profile.  
 
Pressing the plot button displays the release rate profile for the release as shown in 
Figure 3-4. The black line shows the user input for release rate profile and the dotted 
grey lines display the segmentation of the release that DRIFT will use to approximate 
the time-vary release as a series of finite-duration segments.  The segmentation of 
the release rate profile is controlled by two parameters - Release Segment Tolerance 
and Minimum Segment Duration these can be adjusted from their default values 
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using the Preferences dialogue box available from the Settings→Preferences menu 
(see Section 5.0). 
 

 

 
Figure 3-4 Time Varying Release Profile Plot 

 

3.2.14 Pool Results… button 

The Pool Results… button allows a pool source from a GASP run to be added to the 
specified release.  See Case 2 of Section 3.11 for more details. 
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3.3 Geometry Tab 

The Geometry Tab contains inputs relating to the source geometry (location, size and 
orientation).  The input controls displayed on the Geometry Tab depend upon the 
release type selected under the Release Tab. 
 
The geometry tab for an instantaneous release is shown in Figure 3-5. 
 

 
Figure 3-5 Instantaneous Release Geometry Tab 

 
The geometry tab for a continuous or time varying release is shown in Figure 3-6 
 

 
Figure 3-6 Continuous or Time Varying Release Geometry Tab 
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3.3.1 Location 

Co-ordinate System Definition 
 
For the purpose of defining release and wind angles, DRIFT treats East as being in 
the positive x-direction, North as being in the positive y-direction.  These labels do 
not necessarily imply alignment with True North or Plant North and the definition of 
these directions is merely a matter of convenience.   
 
The z-axis is directed upwards with z = 0m corresponding to ground-level.  
 
The (x,y) origin can be chosen to suit the user.  
 
In some cases, e.g., dispersion of a downwind directed release, it may be simplest to 
define the coordinate system relative to the wind with the source at x=0, y=0, such 
that x is the downwind direction and y the crosswind direction. In other cases, e.g. 
when modelling dispersion in the presence of buildings, defining axes based on a 
geographic co-ordinate system may be desirable.  
 
Source Location 
 
Use the location inputs to specify the (x, y, z) location of the central point of the 
release source.   
 
z = 0 m specifies a ground-level source.  For an elevated stack release specify z 
equal to the stack height, reduced if appropriate to account for stack down-wash (see 
below). Instantaneous and low momentum area sources are always at ground-level. 
 
Stack downwash 
 
DRIFT does not model downwash for stack releases.  Stack downwash affects 
releases with relatively small upward momentum - it reduces plume rise due to the 
turbulent wake around the stack.  In circumstances where the vertical release 
velocity is less than approximately 1.5 times the wind speed at the stack height, 
consideration should be given to reducing the stack height by an amount indicated by 
accepted stack downwash algorithms. 
 

3.3.2 Initial Cloud Radius [Instantaneous] 

The initial instantaneous cloud is taken to be cylindrical, and the initial radius of the 
cloud can be entered in the text box. Use the unit aspect ratio check box to tell 
DRIFT to take the height of the cylinder to be the same as its radius. – in this case 
DRIFT calculates the initial cloud radius at runtime. 
 
A unit aspect ratio cloud might be considered an appropriate approximation for a 
pressurised catastrophic failure where a hemi-spherical cloud is expected to initially 
form.  In the case of a release from a pool it may be more appropriate to input the 
pool radius as the initial cloud radius. 
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3.3.3 Source Type [Steady Continuous, Finite Duration, Time Varying] 

The following source types are available for steady continuous, finite duration and 
time varying sources: 
 

• Momentum Jet 
 
The momentum jet option should be selected for modelling directed 
dispersion resulting from a pressurised release through an orifice.  
 

• Low Momentum Area Source 
 
The low momentum area source should be selected when DRIFT is being 
used to model dispersion from a low momentum source, such as vapour 
evolution from an evaporating pool. The low momentum model does not apply 
exclusively to a pool however, although this does seem like the most likely 
use. 
 
Generally, for a pool the release rate would be the vaporisation rate; the 
release temperature would be the temperature of vapour evolving from the 
pool (which for most pool models is the same as the pool, or, if different, the 
pool surface temperature); and the pressure would be atmospheric.  
 
Specifying a liquid/two-phase option would be equivalent to having a low 
momentum aerosol release spread over the source area. It is unclear in what 
practical circumstance this would apply (possibly a two-phase release through 
a cyclone device). The liquid option is not intended to be a source from a 
pool. If the liquid/two-phase option were used, then the rainout fraction would 
specify the fraction of post-flash liquid that rains out (rained out liquid does 
not contribute to the cloud). The input pressure is the pressure at the exit. For 
jet releases this is used to calculate the initial momentum; for low momentum 
sources it is probably best to set the pressure to atmospheric to be consistent 
with the source having low momentum. 

 

3.3.4 Orifice Diameter [Momentum Jet, Low Momentum Area Source] 

The diameter of the release orifice for a momentum jet. 
 
The diameter of area source (e.g., pool radius) for a low area momentum source. 
 
DRIFT assumes that the release occurs through a circular orifice or hole.  In the case 
of a non-circular source, a diameter should be input which has an equivalent area.  
However, this may be a poor approximation in the near field for releases through slits 
where the along slit dimension is much larger than the across slit dimension. 
 

3.3.5 Include Dilution Over Source [Low Momentum Area Source] 

When this is selected [the default] DRIFT will include dilution due to mixing with air 
over the area source and, if predicted, upwind spreading for a dense source. 
 
DRIFT's model for dilution and spreading over the source attempts to find a steady 
state solution where the material released from the source moves downwind at a rate 
equal to the rate of release from the source.  In some circumstances (low wind and 
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large release rate) DRIFT may predict that in the steady state, the cloud has diluted 
(on average) below the level of concern – this is indicated by a runtime warning 
message. 
 
When calculating initial dilution DRIFT runs a modified version of the instantaneous 
model (with a source rate feeding into the cloud) until an appropriate steady source 
window can be set up. In the case of the steady continuous model this initial upfront 
instantaneous run is discarded once a source window has been established; in the 
case of the finite duration and time varying models the instantaneous run is included 
in the time-history of the concentration profiles. Note that occasionally the transient 
concentration contours can be bigger than the steady state contours around the 
source, meaning that the finite duration model predicts a larger cloud footprint than 
the steady continuous model.  
 

3.3.6 Discharge Coefficient [Momentum Jet] 

The entered discharge coefficient should match that used for the discharge rate 
calculation.  Generally different values are used for liquid and gases.   
 
DRIFT default inputs are: 0.61 for liquids and 0.80 for gases. 
 
DRIFT uses the discharge coefficient to calculate the exit velocity corresponding to 
the supplied release rate. The release rate itself is unchanged from the input value. 
 

3.3.7 Release Direction [Momentum Jet]  

The initial release direction for a momentum jet is set by specifying two angles: 
 

• Angle from Horizontal 
The angle in degrees between the initial jet direction and the horizontal plane. 
A positive angle represents a jet initially tilted upwards from the horizontal, a 
negative angle an initially downward tilted jet and zero an initially horizontal 
jet. Valid input range: +90º to -90º. 

 

• Angle from North 
The bearing angle (in degrees) clockwise from the North (y-axis) in which the 
momentum jet is initially pointing.  The default, 90º, corresponds to a release 
directed along the x-axis.  Valid input range: 0º to 360º, except for time 
varying jets which must be directed within 60º of the downwind direction (e.g., 
30º to 150º if the wind blows along the x-axis).   

 
Depending on the trajectory of the jet, DRIFT may encounter modelling difficulties 
(returning one of the solver related errors in Section 6.0) for certain combination of 
release and wind angle – generally these correspond to conditions where there is 
predicted to be a reversal of the flow, e.g. a jet directed into the wind, or a dense jet 
that is initially vertical upwards.  In such circumstances, it may be possible to run the 
scenario by adjusting the release direction and/or the wind direction. 
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3.4 Atmosphere Tab 

The Atmosphere Tab, shown in specifies the atmospheric conditions to apply to the 
dispersion scenario.  
 

 
Figure 3-7 Atmosphere Tab 

 
 

3.4.1 Weather Scheme 

DRIFT supports the following schemes for input of atmospheric conditions: 
 

• Pasquill 

• Holtslag 

• Monin-Obukhov 
 
The user only needs to enter information for one of the three schemes.  DRIFT 
converts, at runtime, the input from either the Pasquill or the Holtslag scheme into an 
equivalent Monin-Obukhov scheme and uses this for the calculation of atmospheric 
dispersion. 
 

3.4.2 Inversion Height  

DRIFT models dispersion only within the atmospheric boundary layer (also called the 
atmospheric mixing layer).  DRIFT conservatively assumes that all released material 
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remains trapped within the atmospheric boundary layer.  The top of this layer is 
defined by the inversion height. 
 
User input of inversion height is only required for the Monin-Obukhov scheme.  For 
the other weather schemes the inversion height is either calculated (Holtslag) or 
determined from a look-up table (Pasquill).  Optionally, the user may input an 
inversion height for any scheme by checking the input inversion height check box. 
 

3.4.3 Temperature  

The air temperature in Kelvins at the Reference Height. 
 

3.4.4 Relative Humidity  

Relative humidity is a measure of the water content of moist air relative to saturated 
conditions.   
 
Valid range: 0% - 107% 
 
Relative humidity may affect dispersion behaviour through latent heat 
released/absorbed when condensing/evaporating water drops in the cloud (this can 
affect the predicted behaviour of dispersion of a cold LNG cloud). Relative humidity 
may also influence the dispersion behaviour of released substances which strongly 
interact with water releasing heat.  DRIFT includes specific water interaction models 
for ammonia and hydrogen fluoride. 
 
DRIFT defaults to the specific humidity being constant with height (apart from in the 
Holtslag scheme, see below).  This can be altered by specifying the Inverse Bowen 

Ratio on the Preferences dialogue box accessed via the Settings→Preferences 
menu (see Section 5.0), in which case relative humidity varies with height and the 
input relative humidity should be at the Reference Height. In the Holtslag scheme the 
Bowen Ratio is calculated automatically by the model. 
 

3.4.5 Reference Height  

This is the height above the ground at which the input wind speed, air temperature 
and relative humidity (in the case of varying relative humidity with height) apply. 
 

3.4.6 Roughness Length  

The roughness length (z0) is a characteristic of the roughness of the terrain over 
which the dispersion occurs.  Roughness length, together with Monin-Obukhov 
length and friction velocity are scaling parameters for the atmospheric boundary 
layer. 
 
Roughness length may be estimated simply based upon land-use type or using more 
sophisticated methods.  Guidance on estimating roughness length is given Hanna 
and Britter's CCPS book 'Vapor Cloud Dispersion at Industrial and Urban Sites', 
ISBN: 0-8169-0863-X. 
 
In general, higher roughness length gives rise to more cloud dilution and short 
hazard ranges. 
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Note: The Pasquill weather scheme is strictly only valid for roughness lengths 
between 0.0001 m and 0.5 m.  Values outside this range are permitted by DRIFT, but 
should be used with caution. 
 

 

3.4.7 Wind Angle from North 

Specifies the direction from which the wind is blowing. The angle is measured in 
degrees clockwise from North (y-axis). 
 
For example, a wind angle of 270º [the default] corresponds to the wind blowing 
towards the positive x-direction from the west (negative x-direction). 
 
Note: The wind direction convention used here differs from that in DRIFT version 2, 
but matches standard meteorological convention.  DRIFT automatically corrects for 
this when reading a legacy DRIFT input file. 
 
Valid input range: 0º to 360º 
 
Depending on the trajectory of the cloud, DRIFT may encounter modelling difficulties 
(returning one of the solver related errors in Section 6.0) for certain combination of 
release and wind angle – generally these correspond to conditions where there is 
predicted to be a reversal of the flow, e.g. a jet directed into the wind.  In such 
circumstances, it may be possible to run the scenario by adjusting the release 
direction and/or the wind direction. 
 
 

 

3.4.8 Wind Speed [Pasquill, Holtslag] 

The wind speed (measued in metres per second) at the specified reference height. 
 
Note: DRIFT cannot model dispersion in zero wind speed. 

 

3.4.9 Pasquill Stability [Pasquill] 

This is the categorisation of the atmospheric stability. The Pasquill categories are 
defined as follows: 
 
A:  very unstable 
B:  unstable 
C:  slightly unstable 
D:  neutral 
E:  slightly stable 
F:  stable 
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Table 3-1 A guide to Pasquill categories (Panofski and Dutton (1984)) 

 Day- Incoming Solar Radiation Night 

10m wind 
speed 

Strong Moderate Slight Thinly 
Overcast 
or >4/8 
Low Cloud 

Clear or 
<3/8 Low 
Cloud 

< 2 A A-B B   

2-3 A-B B C E F 

3-5 B B-C C D E 

5-6 C C-D D D D 

> 6 C D D D D 

 
Pasquill category A indicates strong convection (and large vertical dispersion). D 
represents purely mechanical turbulence, and F implies stable air in which 
mechanical turbulence is strongly damped by stratification.  The neutral category, D, 
should be assumed for overcast conditions during day or night.  No Pasquill category 
is defined for clear night or light wind, where vertical turbulence is eliminated - in this 
circumstance F stability is a pragmatic choice. 

 

3.4.10 Cloud Cover [Holtslag] 

The Holtslag weather scheme uses the cloud cover, together with the latitude, 
longitude, date and time, to calculate the net solar radiation. The net solar radiation is 
an input to calculating the Monin-Obukhov length and inversion height. 
 
Valid range: 0%-100% 

 

3.4.11 Latitude, Longitude, Date & Time [Holtslag] 

The Holtslag weather scheme uses the latitude and longitude of the site, together 
with the date and time (GMT 24 hour clock) and cloud cover, to calculate the net 
solar radiation. The net solar radiation is an input to calculating the Monin-Obukhov 
length and inversion height. 
 
Valid range for Latitude:  +90º   to -90º  
Valid Range for Longitude +180º   to -180º 

 

3.4.12 Inverse Monin-Obukhov Length [Monin-Obukhov] 

The Monin-Obukhov length, La, is a fundamental scaling length for the atmospheric 
boundary layer.  For the Pasquill and Holtslag weather schemes, the Monin-Obukhov 
length is calculated/looked-up by DRIFT from the supplied inputs.   
 
To avoid singularities under neutral stability conditions, the Monin-Obukhov length is 
directly input via its inverse i.e. 1/ La. 
 
The inverse Monin-Obukhov length is zero for neutral stability, positive for stable 
stratifications and negative for unstable stratifications. 
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3.4.13 Friction Velocity [Monin-Obukhov] 

The friction velocity is a characteristic scaling velocity for the lower parts of the 
atmospheric boundary layer.  For the Pasquill and Holtslag weather schemes, the 
friction velocity is determined from the input wind speed, roughness length and 
reference height.  For the Monin-Obukhov weather scheme the friction velocity is a 
direct input. 
 
Note: DRIFT cannot model dispersion in zero friction velocity (corresponding to zero 
wind) 
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3.5 Toxic Tab 

When the toxic target type is selected, the targets tab is shown in Figure 3-8. The tab 
is split under a variety of subheadings which are described below. 
 

 
Figure 3-8 Toxic Targets Tab 
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3.5.1 Time Averaging 

If the Use Time Averaging checkbox is checked then DRIFT will account for lateral 
and vertical meander of the plume induced by fluctuations in wind direction.  
 
The lateral meander model in DRIFT uses a fluctuation model based on the EU 
COFIN project. This takes the averaging time as an input, which is the period in 
seconds over which to average the toxic concentration and dose predictions. In 
general, the longer the averaging time the more the effective the dilution due to 
plume meander.  For toxic exposure it is usual for the averaging time to match the 
assumed toxic exposure duration, or release duration if shorter.  This is the default in 
DRIFT. 
 
DRIFT also has a vertical meander model to account for the effects of updraughts 
and downdraughts, but this only applies in unstable atmospheric conditions. The 
averaging time has no effect on the vertical meander. 
 
Time averaging has no effect on the predicted dilution of instantaneously released 
clouds. 
 
IMPORTANT NOTE: Only the output displayed in the toxic and general results 
windows and in the toxic results section of the DRIFT report (printed or HTML) 
include the effect of time averaging.  All flammable results are based on short 
(near-instantaneous) average values.  All custom plots and tables are also 
based on short (near-instantaneous) average values. 
 

3.5.2 Toxic Dose 

In this group box the following inputs are specified: 
 
Maximum Exposure Duration  
 
The maximum exposure duration in seconds is used to limit the time over which toxic 
dose is accumulated.   
 
Where the maximum exposure duration is shorter than the passage time of the cloud, 
DRIFT reports the toxic dose corresponding to the maximum exposure duration (plus 
the Indoors Lag Time for an indoors target) for the worst case (highest dose) time 
interval during the passage of the cloud. 
 
The default in DRIFT is for the maximum exposure duration to be set equal to the 
release duration. 
 
Toxic Exponent, n  
 
The toxic exponent, n, is the power to which the concentration (in parts per million) is 
raised when integrating over time to calculate the toxic dose. 
 
Enter a toxic exponent for each component substance by clicking on the number 
displayed next to the substance name and entering the value.  A value of zero may 
be used to indicate that a component does not contribute any toxic dose.  
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DRIFT reads the toxic exponent from HSE SPI files (when present) which include 
toxicity information.  In this case the toxic exponent read from the SPI file is displayed 
but cannot be changed in DRIFT. 
 
Toxic exponents can be found from a variety of sources such as the HSE website. 
The recommended values are updated from time to time so users are advised to 
check for the latest values. 
 

3.5.3 Target Indoor Parameters 

DRIFT uses a simple indoor ventilation model to calculate the toxic concentration and 
dose for indoors targets. The required inputs are: 

• Ventilation Rate 
 
Indoor ventilation rate is specified in air changes per hour.  Higher ventilation 
rate will lead to greater indoor concentrations and dose.  In general natural 
ventilation will be wind speed dependent, with higher wind speeds leading to 
higher ventilation rates. 
 

• Indoors Lag Time 
 

Indoors Lag Time is the time in seconds that people are assumed to remain 
indoors after the toxic cloud has passed.  The default lag time in DRIFT is 
600 seconds. The Indoors Lag Time is added to the Maximum Exposure 
Duration to determine the worst case indoors toxic dose. 

 

3.5.4 Levels of Interest 

This subsection allows the user to define specific toxic doses or toxic concentrations 
of interest for DRIFT to calculate the hazard ranges for and plot concentration/ dose 
contours. 
 

• Adding Levels of Interest 
To add a level of interest the user should select if the level is indoors or 
outdoors from the right-hand drop-down list and from the left hand drop down 
list either a concentration or a dose of interest should be selected. The level 

of interest can then be added by clicking on the  button. 
 
The substance(s) will now become available within the Substance-Level text 
box and the user can add either a concentration level of interest (in ppm) or a 
dosage level of interest (in ppmn.min, where n is the toxic exponent).  
 
Additional indoor and outdoor levels of interest can be added by the same 
method and they can be switched between by using the drop down list. To 

remove a level of interest, select it in this fashion and then click onto the  
next to the drop-down list. 
 
Where there is toxicity information in the HSE SPI file, DRIFT will 
automatically load the 1% fatality level (SLOT DTL) as indoor and outdoor 
levels of interest.  These particular levels cannot be edited with DRIFT, 
although new levels may be added. 
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Note that the averaging time, maximum exposure duration and toxic exponents 
always need to be entered, even if no toxic levels of interest are added, because they 
are used when computing dose results for the general tab. 
 

3.5.5 Method of Evaluating Toxic Dose Fraction 

DRIFT offers two alternative methods for combining the results for multi-component 
toxic releases: 
 
Method 1 
 
This involves adding the fractions of the target level concentration and doses.  For 
each stored level of interest DRIFT outputs results corresponding to the sum over the 
component fraction of target levels equalling 1.  This may be represented by 
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where iC  is the specified level of harm for component i corresponding to the 

concentration or dose,  iz  is the predicted concentration or dose and i signifies 

the sum only applies to those components that are toxic. 
 

This approach assumes that each added level of interest, iC  corresponds to same 

level of harm (e.g., a specified level of toxicity).  In this approach each toxic 
component is assumed to be 'independent'.  This has the merit that when a single 
component dominates the composition, the predicted toxic fractions match tends to 
those for that component.   
 
Method 2 
 
An alternative method of combining toxic dose (method 1 is always employed for 
toxic concentration) for components is: 
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where in  is the toxic exponent for component i.  This alternative approach has the 

merit that for multiple components with similar or the same toxicity (same or similar 

target dose levels iC  and toxic exponents in ) then similar or the same results would 

be found using a single component with the same toxicity.  This would only be the 

case in Method 1 if 1=in and for other circumstances, e.g., with 2=in  then Method 

1 might be considered non-cautious. 
 
It is recognised that combining toxicity for multi-component mixtures in either of the 
above ways is at best uncertain. Should mixture specific toxicity be available it would 
be preferable to apply this more directly (e.g., by inputting this as a toxic dose 
equivalent for a single component) 
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3.6 Flammable Targets 

 
When the flammable target tab is selected, the targets tab shown in Figure 3-9is 
shown. The tab is split under a variety of subheadings which are described below. 
 

 
Figure 3-9 Flammable Targets Tab 

 
 

3.6.1 Flammable Limits 

By default, DRIFT extracts the Lower Flammability Limit (LFL) and Upper 
Flammability Limit (UFL) for the released substance from the substance property 

data source (set via Settings→Substance Data Source, see Section 2.2).  In the 
case of multi-component releases, DRIFT calculates the flammable limits from those 
of the components using Le Chatelier's empirical mixing rule. 
 
The Lower and Upper Flammability Limits are displayed and input as %mol/mol 
values.  It should be noted that these limits relate to the flammable components of 
the mixture only.  This means that the mixture of a flammable component (e.g., 
methane) with a non-flammable component (e.g. air) will have flammability limits the 
same as that of the pure flammable component. 
 
Check the User Input Flammability Limits box to manually enter the Lower 
Flammability Limit (LFL) and Upper Flammability Limit (UFL) of the release.   
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Values for user defined substances can often be found on material safety data 
sheets (MSDS).  
 

3.6.2 Levels of Interest  

Levels of interest to various fractions of the LFL can be added by clicking on the 
green cross underneath the text box. The fraction can be greater than unity. To 
delete a level of interest select it by clicking on the level and then clicking the red 
cross button. 
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3.7 Defining New Release Substances 

Pressing the Define button on the Release Tab displays the dialog box shown in 
Figure 3-10. 

 
Figure 3-10 Define Substance Dialogue Box 

 

Selecting single component allows the user to specify a new substance and selecting 
multi-component allows the properties of a mixture of substance to be defined. 

3.7.1 Defining a New Single Component Substance 

If the user selects Single component in the Define Substance dialogue box, the 
User Defined Substance Properties dialogue box shown in Figure 3-11 is displayed.  
The input data in this window is initially populated using data for the initially selected 
database substance.  The user can edit/enter new substance property data 
appropriate for the new substance to be modelled.  
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Figure 3-11 User Defined Substance Dialogue Box 

 
Required substance property data are: 
 
Substance Name  Name of the substance 
 
Molecular Weight  Molecular weight of the substance in g/mol 
 
Is Condensible Determines whether the substance can condense as 

liquid in the cloud. If this is set to false then several of 
the other inputs below do not need to be input and will 
be greyed out appropriately. 

 
Critical Temperature  The critical temperature, Tc, in Kelvins. 

 
Liquid Density  The liquid density, assumed to be constant, in kg/m3.  

 
Vapour Heat Capacity Heat capacity of vapour, assumed to be constant, in 

J/(kg K) 
 

Liquid Heat Capacity Heat capacity of liquid, assumed to be constant, in 
J/(kg K). 
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Antoine Coefficients for Vapour Pressure 
 

The Antoine correlation used by DRIFT is  
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where vP  is the vapour pressure in Pascals, T is the temperature in Kelvins,  refP  is a 

conversion factor (=133.322) from millimetres of mercury (mmHg) to Pascals and A, 
B and C are the Antoine coefficients. The units of A, B and C as used by DRIFT are 
ln(mmHg), ln(mmHg) K and K respectively. 

 
Note on Antoine coefficients: 
 
A number of different forms of the Antoine correlation are published, some simply 
involving different units, some using a different base e.g. log10 of the vapour pressure 
instead of the natural logarithm ln.  It is important to correctly convert from these to 
the form and units used by DRIFT.  For example, if a reference gives Antoine 
coefficients for Bromine of A = 9.2239 ln(bar) , B = 2582.32 ln(bar) K and C = -51.56 

K based upon vP  being in bar and T in Kelvins and an Antoine correlation of the 

form: 
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To convert the above coefficients to the units required by DRIFT we need to adjust 
the coefficient A by first adding ln(105) to convert from ln(bar) to ln(Pascals) and then 
subtracting ln(133.322) to convert from ln(Pascals) to ln(mmHg).  Thus the user 
would input to DRIFT A = 15.844, with B and C unchanged.  A useful check that the 
Antoine coefficients are correctly entered is, once the User Defined Substance 
Properties dialogue is accepted, to set the pressure on the Release Tab to equal 
ambient pressure (101325 Pascals) and to press the Sat Temp. button. This should 
set the temperature equal the normal boiling temperature in Kelvins. Remember to 
reset the temperature and pressure to the correct release values after this check. 
 
Heat of Vaporisation 

 
DRIFT determines the heat of vaporisation as a function of temperature, T using 
Watson’s formula: 
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where ∆Hb is the heat of vaporisation (J/kg) at the normal boiling point Tb (referred to 
as the latent heat reference value) , Tc is the critical temperature and n is an index to 
parameterise the temperature dependence (n is referred to as the latent heat of 
vaporisation index).  
 
Guidance:  Reid, Prausnitz and Poling (1987) suggest that n is typically 0.38.  
Where the temperature dependence is not known the user may input the known 
latent heat with a value of n set to zero. 
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Binary Diffusion Coeff in Air 
 
The binary diffusion coefficient (in m2/s) of the substance in air is used by DRIFT for 
calculating vapour deposition to the ground.  Vapour deposition is enabled by 
selecting Deposition to the ground using the Ground Transfer menu option (see 
Section 3.7).  Methods of estimating binary diffusion coefficients are given in for 
example: Reid, Prausnitz and Poling (1987) “The Properties of Gases and Liquids”, 
ISBN: 0070517991. 
 
Is Flammable, Lower Flammability Limit, Upper Flammability Limit 
 
Checking the isFlammable box specifies that the substance is flammable.  When this 
box is checked the user should enter the lower and upper flammable limits in % by 
mol. 
 

3.7.2 Defining a Multi-Component Mixture 

If the user selects Multi-component in the Define Substance Properties dialogue 
box then Mixture Editor dialogue box shown in Figure 3-12 is displayed.   

The Mixture Editor dialogue box allows the user to name a mixture and define its 
composition. 

 
Figure 3-12 Mixture Editor Dialogue Box 

The Mixture Editor allows a wide range of multi-component mixtures to be specified, 
ranging from simple mixtures of vapour components to multi-component two-phase 
mixtures.  Liquid phases may be specified as either being miscible with water, or as 
being in a separate distinct liquid phase (immiscible).  DRIFT supports there being 
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multiple distinct liquid phases referred to as ‘Liquid Phase 1’, ‘Liquid Phase 2’, etc. 
Each distinct liquid phase can consist of multiple substance components that are 
assumed to mix ideally (i.e., obey Raoult’s Law) within that phase.  ‘Miscible with 
Water’ is a special phase reserved for substances that form an ideal solution with 
water.  DRIFT also contains non-ideal mixing models for the hydrogen fluoride-water 
and ammonia-water interactions. 

The user can add mixture components by selecting the substance from the upper 
drop down menu and specify if the substance is ‘Miscible with Water’ or add an 
additional Liquid Phase by using the lower drop down menu.  For each additional 
substance added, a separate phase level can be added for the substance, or it can 
be added to an existing Liquid Phase. 

Example 

To model a mixture of water, isobutane and n-butane the user is advised to 
use Liquid Phase 1 for both isobutane and n-butane as they are both miscible 
with each other but essentially immiscible with water. If an additional 
substance was to be modelled which is immiscible with water, isobutene and 
n-butane then the user would add this substance in the now available Liquid 
Phase 2.  

To add the substance the user selects the name from the drop down list and the 

liquid phase and clicks the  button. To delete a substance click on the substances 

name in the table and then click on the  button which becomes available.  Note 
that the air and water options cannot be deleted; however leaving their vapour and 
liquid compositions as zero will exclude them from the mixture. 

The mixture composition can be specified either on a molar or a mass basis 
depending on the Moles and Mass radio buttons in the ‘Composition Defined By’ 
group box. 

To input the mixture vapour and liquid composition select the composition to be 
changed by double clicking on the number and inputting the required value.  The 
input values do not need to add to 1.0, but should result in the correct proportioning 
between phases and the correct composition within each phase. 

At the start of the run DRIFT does a flash calculation to determine the phase content 
of the initial cloud - consistent with the initial enthalpy, the overall mole fractions 
(irrespective of phase) and phase equilibrium (if liquid is predicted to be present).  In 
the circumstance that the flash calculation indicates the phase remains all vapour 
then the mole fractions and temperature will remain unchanged.  In the circumstance 
that there is predicted to be liquid present then the model will determine the 
partitioning between phases based upon the flash calculation - this will differ from the 
input phase composition if the initial input conditions are not consistent with phase 
equilibrium.  The flashing is assumed to be instantaneous - therefore the change 
shows at time t = 0 seconds. 
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3.8 Ground Transfer 

By default, DRIFT neglects heat and mass transfer between the cloud to the ground.  
However, heat and mass transfer can be modelled as an option. 
 

Selecting the ground transfer option under the main menu bar, Scenario→Ground 
Transfer… displays the ground transfer window shown in Figure 3-13. Use this 
option to specify the Heat and Mass Transfer to the ground. 
 

 
Figure 3-13 Ground Transfer Dialogue Box 

 
 

• Heat Transfer to Ground 
 
To calculate the forced/convective heat transfer from the ground requires the 
ground surface temperature to be input in Kelvin.  The default is to neglect 
heat transfer from the ground. 
 

• Deposition to Ground 
 

When the Deposition to Ground tick box is checked, DRIFT will calculate 
mass transfer (vapour and liquid deposition) from the cloud to the ground 
when they are in contact.  If this option is not selected DRIFT will assume 
there is no mass transfer from the cloud to the ground. 
 
Optionally a fixed vapour (dry) deposition velocity can be specified by 
checking the ‘Use Fixed Deposition Velocity’ checkbox and entering a value 
for the deposition velocity in m/s. 
 
Alternatively, DRIFT calculates the deposition of vapour based upon the 
calculated atmospheric resistance.  The surface resistance relates to the 
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resistance at the surface which is likely to be dependent upon the nature of 
the surface and reactivity of the deposited substance.  Zero surface 
resistance corresponds to all material transported to the surface being 
absorbed.  The leaf area index is a multiplier of the surface area to account 
for the area of leaves absorbing the material being higher than the planar 
area of the ground surface. 
 
Max Dry Deposition velocity is for future use only. Currently changing its 
value has no effect. 
 
Calculation of liquid deposition requires the input of a non-zero mean drop 
diameter – this is the initial mean drop size after liquid break-up and 
immediate rainout (specified using rainout fraction on the Release Tab -see 
Section 3.2.7).  DRIFT will shrink the mean drop size based upon the 
evaporation rate calculated by the Homogeneous Equilibrium thermodynamic 
model.  Liquid deposition continuously removes liquid from the cloud base 
until no liquid remains. Liquid deposited in this way is permanently removed 
from the cloud and will not re-vaporise. 
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3.9 Termination Criteria 

Selecting the Termination Criteria option under the main menu bar, 

Scenario→Termination… displays the Termination Criteria dialogue box shown in 
either Figure 3-14 or Figure 3-15.  If not already terminated due to exceeding the 
distance to the requested levels of interest, DRIFT will run the dispersion model until 
one of the Termination Criteria is exceeded. 

 

 
Figure 3-14 Termination Criteria Dialogue Box for Instantaneous Release 

 

 
Figure 3-15 Termination Criteria Dialogue Box for Non-Instantaneous Releases 

 

• Dilution Factor 
 

Terminate when the cloud concentration divided by the initial cloud 
concentration falls below this value. 

 

• Minimum Concentration 
 

Terminate when the cloud concentration in parts per million falls below this 
value. 
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• Maximum Travel Distance 
 

This is the maximum distance for the containment cloud to travel in metres. 
Note that when this distance is very short (e.g. <10m) it may be desirable to 
decrease the minimum slice separation on the preferences dialog (see 
Section 5.0) so that the required level of accuracy is maintained.  

 

• Maximum Computing Time 
 
This is the maximum time for DRIFT to run (compute) a release scenario in 
seconds.  
 

• Maximum Travel Time 
 

This is the maximum time for the cloud to travel, in seconds, before the model 
terminates.  
 

• Maximum Downwind Extent 
 
This is the maximum downwind spread of the cloud before the model 
terminates. 
 

• Maximum Crosswind Extent / Maximum Plume Width 
 

This is the maximum crosswind spread of the cloud before the model 
terminates. 
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3.10 Obstacles 

DRIFT incorporates sub-models for the interaction of dispersing clouds with simple 
obstacles such as cuboid buildings and linear fences.  Interaction with such obstacles 
can induce extra mixing and spreading of the cloud.  Interaction of dispersing clouds 
with obstacles such as buildings and fences is in reality very complex, the obstacle 
interaction models in DRIFT are intended only to give an indication of overall bulk 
effects on the cloud and not a detailed representation of the changes to the 
concentration in the immediate vicinity of obstacles.  DRIFT’s obstacle models cover 
dense and passive releases only (i.e., they are not applicable to momentum jets or 
buoyant clouds).  The user is referred to the EU FLADIS Report (AEA Technology 
AEA/CS/FLADIS/1994 Vol 2 Issue 1) for the scope and validation of the obstacle 
models in DRIFT. It should be noted that the obstacle models are not valid in the 
circumstance that the obstacle lies within the low momentum area source and 
dilution over the source is being calculated.  
 

Obstacles are specified via the Scenario→Obstacles… menu which displays the 
Add Obstacles dialogue box shown in Figure 3-16. 
 

 
Figure 3-16 Add Obstacles Dialogue Box 

 
 
Obstacles can either be specified as buildings or fences. Fences can be specified as 
either an infinite fence a specified distance from the release source or as a finite 
fence  
 

3.10.1 Buildings 

Pressing the ‘Create a new building’ button causes the Add Obstacles dialogue box 
to display the inputs shown in Figure 3-17. 
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Buildings are input as rectangular obstacles inserted at a central coordinate and 
angle from North of the longest side.  The building length, width and angle definitions 
are illustrated in Figure 3-18. 

 
Figure 3-17 Adding a New Building 

 
 

 
Figure 3-18 Building Definitions 

 
 
 
 

North 

Angle from 
North 

Length 

Width 
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3.10.2 Fences 

Pressing the ‘Create a new fence’ button causes the Add Obstacles dialogue box to 
display the inputs shown in Figure 3-19. 
 

 
Figure 3-19 Adding a New Fence 

 
Fences can be specified as either an infinite fence a specified distance from the 
release source or as a finite fence.  An infinite fence is always assumed to be 
perpendicular to the direction of cloud travel at the specified.  The geometry (location, 
length and orientation) of finite fences is defined in the same way as for buildings, 
except that fences do not require a width.  
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3.11 Importing Pool Vaporisation Results from GASP 

Results from a pool vaporisation calculation using GASP can be directly imported 
into DRIFT for defining a dispersion scenario.  DRIFT requires that the GASP run has 
been saved as a GASP Version 4 file with file extension .gasp. 
 
There are two ways of using GASP results: 
 

1. The only source is vaporisation from the pool 
2. Add the pool source term to a user specified instantaneous, steady 

continuous, finite duration or time varying release 
 
Case 1: Only source is from Pool Vaporisation 
 

To import the results from a GASP run go to File→Import Gasp Results… on 

DRIFT’s menu and browse to the .gasp file (or click on the  icon on the tool bar).  
Once the file is imported DRIFT displays graphs of the vaporisation rate, pool radius 
and pool temperature in tabs in the right-hand window as shown in Figure 3-20.  The 
dotted lines on these graphs show the default segmentation that shall be applied by 
DRIFT for the run.  As for Time Varying releases, the segmentation of the release 
rate profile is controlled by two parameters - Release Segment Tolerance and 
Minimum Segment Duration these can be adjusted from their default values using the 

Preferences dialogue box available from the Settings→Preferences menu (see 
Section 5.0). 
 
  

 
Figure 3-20 Imported GASP Run 

 
In addition to importing time varying source conditions from the GASP file, DRIFT 
also reads the Atmosphere inputs from the GASP file.  Certain inputs on the Release 
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and Geometry Tabs are not applicable when a GASP run is imported and are 
disabled (shown as grey). 
  
Targets may be set on the Targets Tab as for other types of release and DRIFT run 
as described in Section 4.0. 
 
Case 2: Add the pool source term to a user specified instantaneous, steady 
continuous, finite duration or time varying release 
 
In this case set up the release conditions for the non-pool source.  This defines the 
‘direct’ source or primary source which might be the release minus liquid rained out 
into the pool.  Then import the pool source by pressing the ‘Pool Results…’ button on 
the Release Tab.  DRIFT will run the dispersion from the ‘direct’ source and pool as 
separately cloud segments and add together the concentrations from each of these 
to give an approximation for the combined effect. 
 

 
Figure 3-21 Example of combined flammable results from a pool and gas jet 

 
Note: DRIFT can sometimes struggle to contour the output from the added segments 
and the combined results should be inspected carefully before being accepted.  In 
some cases overlapping segments can give unphysical spikes in the concentration-
time history. 
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4.0 Running the Model and Viewing Output 

4.1 Running DRIFT 

Once the input model parameters are entered, including setting of target levels, 

DRIFT is run by clicking on the Run Model   button ,or using the ‘Ctrl + R’ 
keyboard shortcut. 

DRIFT will then immediately begin calculating your results. Most simulations run very 
quickly on modern hardware (of the order of a few seconds).  Any information or error 
messages about the calculations will be output to the message window at the bottom 
of the main window. Once the calculation has terminated, assuming that there were 
no critical errors, a set of summary graphs and a summary table are displayed in the 
main window.  By default, the displayed graphs for flammable (toxic) targets are the 
plan and elevation view of the flammable (toxic) hazard ranges and the centre line 
concentration.  The displayed tables include the flammable (toxic) hazard ranges and 
the tabulated values of centre line concentration. A set of general results showing 
graphs and tables of centre line (along the curvilinear trajectory) outdoor 
concentration/dose is also displayed. It is possible to switch between the general, 
flammable and toxic results by selecting the corresponding tab at the top of the 
graphs and tables window. Each of the graphs can be selected by clicking on combo 
box at the bottom left of the graphs and tables window and selecting the graph or 
table of interest. In the case of a continuous release the flammable centre line results 
(on the flammable tab) are for zero time-averaging and may differ from those shown 
on the general and toxic tabs, which include time-averaging. 

The default view of the automatically displayed graphs is to show the maximum 
extent of the hazard ranges over the duration of the release. However the user can 
examine the hazard ranges at a particular time after the onset of the release by un-
ticking the ‘Maximum Over Time’ check box and entering a time of interest in the 
adjacent text box. An example of the main window after a successful simulation is 
shown in Figure 4-1. 

To add grid lines to the graphs for ease of interpretation the user can select the Show 
Gridlines check box at the top left of the graphs and tables window. 

For particular graphs users will be able to select either axis to be logarithmically or 
linearly scaled for ease of interpretation of results. This is achieved by using the 
corresponding toggles available on appropriate graphs. 

Any changes to the input parameters will automatically invalidate the results, causing 
the graphs and tabular data to be erased. Therefore the user should save DRIFT run 

on completion by clicking on the  toolbar button and entering an appropriate run 
name. There is no need to re-run a model to look at the results as all of the result 
data is stored along with the input parameters when you save the file to disk. Loading 
a DRIFT file from disk will automatically display any saved results. DRIFT files are 
stored on disk with a .drift file extension. 
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Figure 4-1 Main Window after a competed run 

The combo box in the bottom left-hand corner of the output window allows the views 
to be changed between the following: 

• Plan view contours 

This displays a plan view (XY plane) contour plot of the levels of interest.  The default 
is for the contours to be a Maximum Over Time and to Use Centreline Height2 – 
these settings ensure that the worst-case contour extents are displayed.  
Alternatively, the user may specify results at a fixed receiver height by unchecking 
the Use Centreline Height box an entering a height above ground in the Receiver 
Height field.  Also, the user may view contours at a specified time for finite duration 
and time varying releases by unchecking the Maximum Over Time box and entering 
the required output time in the Time box. 

• Elevation contours 

This displays elevation (XZ plane) view contour plot of the levels of interest.  The 
user may specify output at a particular time as for the plan view contours.  The 
receiver height has no effect on the elevation contour plot. 

The contour plotting output from DRIFT is intended to give an approximate graphical 
indication of the predicted extents of the cloud.  In some circumstances, e.g. where 
there is a rapid bending of the cloud trajectory, then the contour plot may show 
overlapping cloud sections or omit to show some parts of the contours. It is usually 
obvious when this occurs and often one view (side elevation or plan) gives a better 
representation of the contours. 

 
2 Use Centreline Height corresponds to the contouring at a height following the centreline 
trajectory – for an elevated cloud this height will be above ground-level and will change 
according to the cloud trajectory. 
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• Centreline graph 

This displays the centreline variation of the centreline concentration/dose expressed 
as either a fraction of the lower flammable limit (LFL) for flammables or for toxics as a 
fraction of the input levels of interest (concentration or dose).  The downstream 
distance on this plot is the travel distance along the trajectory of the cloud.  The user 
may specify output at a particular time as for the plan view contours.  Specifying a 
receiver height returns the maximum values for the receiver height. 

• Tabular Results 

For flammables this displays in tabular form: the fraction of LFL at the centreline of 
maximum concentration, and the horizontal half-width distance (from centreline) to 
the specified flammable levels of concern.  For toxics this displays the centreline 
fractions of the target criteria and the half-widths to these.  The user may specify 
output at a particular time as for the plan view contours. Specifying a receiver height 
returns the maximum values for the receiver height. 

• Hazard Ranges 

This displays a summary of the upstream/downstream distances (measured along 
the curvilinear centreline trajectory) and maximum half-widths to the specified levels 
of interest.  In the case of flammables, additional output is given for the Flammable 
Volume and the Flammable Mass.  The Flammable Volume is the maximum volume 
occupied by the flammable mixture plus air which is enclosed by the LFL contour.  
The Flammable Mass is the maximum mass of flammable contaminant, excluding air, 
which is enclosed by the LFL contour.   The time at which the flammable volume and 
flammable mass are at their maximum values is displayed in the Worst Case Time 
fields.  By default, the flammable volume and flammable mass calculations include 
the region of the cloud where the concentration exceeds UFL – optionally this region 
can be excluded by checking the Exclude region within UFL check boxes. 

Section 4.3.1 gives information on changing the displayed graphs and tabulated 
results for user customised results in DRIFT. 

4.2 Warning and Error Messages 

Any error and warning messages generated during the run are displayed in the 
message window below the output window.  Warning and error messages are listed 
in Section 6.0 
 
 

4.3 Output and Reporting 

DRIFT provides the facility to customise the output displayed after a calculation has 
been performed. The user is able to choose which graphs to plot and which variables 
should be listed in the tabular output display. 

The currently defined table and graphs are displayed in the main window immediately 
after a model run has been completed.  
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IMPORTANT NOTE: Only the output displayed in the toxic results window and 
in the toxic results section of the DRIFT report (printed or HTML) include the 
effect of time averaging.  All flammable results are based on short (near-
instantaneous) average values.  All custom plots and tables are also based on 
short (near-instantaneous) average values. 

In addition to displaying results within the DRIFT program, it is also possible to obtain 
a printed hard copy or to export an HTML file of the model specification and a 
summary of the results. These options are described in more detail in section 4.3.2. 

4.3.1 Customising the Output 

By default DRIFT is configured to display graphs of the plan and elevation view of the 
contours to levels of interest, the centreline concentration of the cloud, and tabulated 
values for the concentration and the maximum hazard ranges. These default values 
are mirrored for both Toxicity and Flammability targets and can be accessed via the 
corresponding tabs at the top of the graphs and tables window. 

If the default output does not meet your requirements then the output can easily be 
customised. To open up the dialogue box used to adjust the output, shown in Figure 

4-2, click on the   button on the left of the row of output tabs: 

 
Figure 4-2 Configure Output View Dialogue Box- Graph 

This dialogue box allows the user to select between graphical and tabular results.  If 
the graphical option is selected, then DRIFT displays a list of possible graphs to 
choose from.  When OK is selected, the appropriate graph will appear in a new tab 
on the output window.  In addition, by filling in the name field on the output 
configuration window, the user can give this tab a unique name for ease of reference. 
A complete list of Axis Variables can be found in the tables in Appendix 1.  
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If the table option is checked, then the output configuration dialogue box changes to 
that shown in Figure 4-3. 

 
Figure 4-3 Configure Output View Dialogue Box - Table 

From this dialogue box the user can add any selection of output variables into a 
custom table. The upper list of variables refers to general properties of the cloud as a 
whole; the lower list of variables refers to properties of the individual cloud 
components. The user's choice of variable can be added to the table by clicking on 
its name and pressing the appropriate "add" button (the upper button relates to the 
upper list of variables; the lower button relates to the lower list of variables). Once the 
table is populated with variables, the columns themselves can be reordered, or 
removed altogether, by clicking on the name of the variable in question and using the 
"move up", "move down" and "remove" buttons. 

To remove an output graph or table, simply select the tab in question and click on the 

small   icon that is positioned at the end of the row of output tabs. 

4.3.2 Reporting 

DRIFT provides the capability to produce simple reports about a model run. The 
reports produced by DRIFT are either sent to the printer to obtain a hard copy or 
exported to an HTML file for online viewing. In both report types, DRIFT outputs a 
complete listing of the input parameters, a log of any error or information messages 
that were output during the model run, and a graph of the dispersion distances to the 
flammable and toxic limits at a worst-case time. 

To print out a copy of a report from DRIFT, run your model as normal and then select 

the File→Print Report... menu item, click on the   toolbar button or press the ‘Ctrl 
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+ P’ keyboard shortcut. This will display a standard print dialog from which you can 
choose the printer to use and any other print options. 

To produce an HTML report, select the File→Export to HTML... menu item or click 

on the  toolbar button. This will display a file selection dialog which may be used 
to decide where to save the HTML report to. DRIFT will automatically suggest a 
report name that has the same name as your .drift file but with an .html extension (if 
you have saved one that is). Once you click OK in the file dialog, DRIFT will save 
your report. As a part of this process DRIFT will also create an image file that 
contains the flammable plan view graph. This file will be saved in the same directory 
as the HTML report and will be called "<basename>_gflammablePlanView.png" 
where <basename> is the name that you selected for your HTML report. If you move 
your HTML report to another location at a later date, it is important to remember to 
move the .png file too; otherwise you will not see the graph when you open the report 
in a browser. 

4.3.3 Printing graphs 

DRIFT also allows users to print out individual graphs as a hard copy or to export 
graphs as graphics files (.png files) so that they may be included into other 
documents (e.g. MS Word or Excel). To output a graph, simply select the graph that 
you wish to save in the main window by clicking on the corresponding tab, and then 

choose either the File→Print Selected Graph or File→Export Current Graph 
menu item. Then proceed as for a printed report or an exported HTML report as 
describe above. 
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5.0 Preference Settings 

Preferences settings may be accessed and changed via the Settings→Preferences 
menu which displays the Preferences dialogue box shown in Figure 5-1. 
 

  
Figure 5-1 Preferences Dialogue Box 

 
 

• Distance Precision 
The precision in metres with which to solve for distances to concentration and 
dose. 

• Time Precision 
The precision in seconds when solving for the time of a particular event, e.g. 
for determining the time of maximum concentration or maximum flammable 
volume. 

• Release Segmentor Tolerance 
The tolerance that DRIFT uses for converting a time varying release into 
discrete segments.  This specifies the maximum fractional change allowed in 
release rate between consecutive segments.  In general a smaller value 
produces a greater number segments. 

• Minimum Segment Duration 
The minimum duration that DRIFT uses for converting a time varying release 
into discrete segments.  This specifies the minimum time duration of a 
segment.   

• Number of Points on Contour Plots 
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The number of points that are used for plotting each contour.  Increase this 
number to produces greater detail or smoother plots.  A higher number of 
points will require a longer time to generate the contour plots. 

• Minimum Slice Separation (Continuous) 
DRIFT’s continuous model stores output by writing results to a number of 
discrete ‘slices’ with each slice corresponding to results at a particular 
downstream distance.  The minimum slice separation specifies the minimum 
downstream distance step in metres between output slices. Note that for 
dispersion runs that occur over very short distances this parameter may need 
to be decreased to maintain the required level of accuracy and smoothness. 

• Minimum Slice Separation (Instantaneous) 
DRIFT’s instantaneous model stores output by writing results to a number of 
discrete ‘slices’ with each slice corresponding to results at a particular time 
after release.  The minimum slice separation specifies the minimum time step 
in seconds between output slices. Note that for dispersion runs that terminate 
very quickly this parameter may need to be decreased to maintain the 
required level of accuracy and smoothness. 

• Maximum Slice Separation (Continuous) 
DRIFT’s continuous model stores output by writing results to a number of 
discrete ‘slices’ with each slice corresponding to results at a particular 
downstream distance.  The maximum slice separation specifies the maximum 
downstream distance step in metres between output slices. 

• Maximum Slice Separation (Instantaneous) 
DRIFT’s instantaneous model stores output by writing results to a number of 
discrete ‘slices’ with each slice corresponding to results at a particular time 
after release.  The maximum slice separation specifies the maximum time 
step in seconds between output slices.  

• Tabular Output Decimal Precision 
Specify the number of significant figures to be included in tabular output 

• Inverse Bowen Ratio 
The Bowen ratio, B0, is the ratio of the sensible heat flux from/to the ground 
surface to the latent heat flux due to evaporation/condensation of water at the 
ground surface.  In the case of zero evaporative flux at the surface the 
Bowen ratio is infinite, therefore it is more convenient to work with the inverse 
Bowen ratio 1/B0.  1/B0 is dependent upon the nature of the ground surface.  
If the humidity and air temperature are known at two heights, then 1/B0 can 
be determined (see e.g. Panofsky and Dutton, 1984, Atmospheric 
Turbulence, ISBN 0-471-05714-2).  For daytime conditions 1/B0 is positive 
ranging from 10 for water bodies to 1 for temperate grasslands and 0.1 for 
deserts. At night-time 1/B0 may take either sign and is difficult to determine 
using simple weather schemes. The default in DRIFT is for 1/B0=0 which 
implies a constant specific humidity with height. 

• Solver Tolerance 
The solver tolerance determines the accuracy to which DRIFT will solve its 
equation set. The lower the tolerance the more accurate the solution; the 
higher the tolerance the faster the model will run. Occasionally the solver 
may run into difficulties when the equation set enters a new regime - 
increasing the tolerance may alleviate this. 

• Finite Duration Model Time Series Precision 
Determines the accuracy to which DRIFT calculates the dose received in the 
finite duration and time-varying models. The smaller the value the more 
accurate the results, but the longer the model will take to run. 

• Finite Duration Model Time Series Extent 
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This parameter is used in the calculation of dose in the finite duration and 
time-varying models. It controls how far into the tails of the dose distribution 
to calculate the concentration time series. The number entered is internally 
multiplied by a typical timescale taken for the cloud to pass through the 
particular point of interest. Larger values of this parameter lead to more 
accurate results. The default value is 3. 
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6.0 List of Warning and Error Messages 

Warning and error messages output by DRIFT are given in the following table.
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Warning Message Additional Explanation/Guidance 
All of the release is liquid and has rained-out. 

Terminating model 

Complete liquid deposition has occurred for a sub-cooled liquid source.  
Check that the release conditions do correspond to a sub-cooled liquid and 
that appropriate values have been used for rainout fraction (Section 3.2.7) 
and liquid deposition drop size (Section 3.8). 

A steady source window could not be established during the 

duration of the release. 

This message implies that the release has not yet reached state conditions 
by the time that the release (or release segment) ends - applies only when 
calculating dilution over a low momentum area source or from a GASP pool 
vaporisation run. 
For finite duration, time varying and GASP pool options this message is for 
information only – the model will attempt to model the transient cloud. 
For the ‘steady continuous’ release try re-running using the finite duration 
option.   
This message should not result from an instantaneous release. 

At xx m downstream from the source 

At t = xx s  

 

the cloud centreline has started to lift-off from the 

ground 

 

the cloud centreline has reached ground-level 

 

the cloud has fallen below the top of the atmospheric 

boundary layer 

 

the cloud has hit the top of the atmospheric boundary layer 

(assumed to be impervious) 

 

liquid is now present in the cloud in phase z 

 

there is no liquid remaining in the cloud in phase z 

 

Information regarding changes occurring at a particular downstream 
distance or cloud travel time. 
 
 
 
 
 
 
 
 
 
 
 
 
Liquid phases are referred to by number 0: represents a phase that is 
miscible with water, 1 the first immiscible phase, 2 the second immiscible 
phase etc 
 
 

At xx s the cloud has diluted below the level of interest This message may be given when calculating dilution over the source.  It 
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Warning Message Additional Explanation/Guidance 
before a steady source window could be established. 

 

 

The results shown are from the transient model. 

 

 

 

To see the time-dependent output from the transient cloud 

please re-run the model with the finite-duration option 

selected. 

indicates that the cloud is predicted to have diluted below the lowest level of 
interest before steady state conditions are established.  
 
In the circumstance of a finite duration, time varying or GASP pool options 
DRIFT automatically uses its transient model and no further user 
intervention should be required. 
 
In the circumstance that the user is running the steady continuous model it is 
necessary to re-run using the finite duration model 

At a downstream distance of xx m and a centroid height of 

hh m the cloud has left the xxxx layer and has now entered 

the yyyy layer 

Here xxxx and yyyy refer to named layers in the atmosphere (see 
Mathematical Model Description for details) 

At a time of xx s and a centroid height of hh m the cloud 

has left the xxxx layer and has now entered the yyyy layer 

Here xxxx and yyyy refer to named layers in the atmosphere (see 
Mathematical Model Description for details) 

AtmosphericBoundaryLayer::computeStrata: Numerical routine 

has failed to find a solution. 

This message indicates a problem initialising the layers in atmosphere 
model.  Please check input data.  If the problem persists contact DRIFT 
support. 

AtmosphericBoundaryLayer::getVerticalDiffusivity: The input 

height is above the AtmosphericBoundaryLayer 

This message indicates that the model is attempting to determine conditions 
outside the atmospheric boundary layer.  Please check input data – in 
particular the source height and inversion height.  If the problem persists 
contact DRIFT support. 

AtmosphericBoundaryLayer::getVerticalDiffusivityDerivative: 

The input height is above the AtmosphericBoundaryLayer 

This message indicates that the model is attempting to determine conditions 
outside the atmospheric boundary layer.  Please check input data - in 
particular the source height and inversion height.  If the problem persists 
contact DRIFT support. 

AtmosphericBoundaryLayer::getVerticalDiffusivityIndex: 

Error. Diffusivity not well defined at this height. 

This message indicates that the model is attempting to determine conditions 
outside the atmospheric boundary layer.  Please check input data - in 
particular the source height and inversion height.  If the problem persists 
contact DRIFT support. 

AtmosphericBoundaryLayer::update: The roughness height is 

higher than the surface layer. 

The roughness height is required to be less than 0.1 times the boundary 
layer height.  Please specify a lower roughness height or increase the 
inversion height. 

Calculating initial cloud dilution using the transient For information only. 
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Warning Message Additional Explanation/Guidance 
model 

Could not load results for time-varying model: 

inconsistency between inputs and stored results. 

Indicates a problem loading the results from a time-varying model run.  
Please check the input data and try rerunning. If the problem persists 
contact DRIFT support. 

DRIFTCloudODEModel::interpolateSlice. No results available. This indicates an attempt by the model to interpolate between results slices 
when no results are available.  This may indicate another problem that has 
caused the model not to run.  Please check input data.  If the problem 
persists contact DRIFT support. 

DRIFTContinuousModel::initialise has failed. This message indicates a problem initialising the continuous model.  Please 
check input data.  If the problem persists contact DRIFT support. 

DRIFTContinuousModel::initialise::solve: No solution could 

be found 

This message indicates a problem initialising the continuous model.  Please 
check input data.  If the problem persists contact DRIFT support. 

DRIFTInstantaneousGeometryInitialisor::solve: No solution 

could be found. 

This message indicates a problem initialising the instantaneous model.  
Please check input data.  If the problem persists contact DRIFT support. 

DRIFTContinuousProfile::update_3() Exception thrown when 

evaluating profile functions. 

This indicates a problem with the numerical solution.  Please check input 
data.  If the problem persists contact DRIFT support. 

DRIFTVerticalProfile::F_tilde_v: The profile index 's' is 

equal to zero. 

This indicates a problem with the numerical solution.  Please check input 
data.  If the problem persists contact DRIFT support. 

DRIFTVerticalProfile::F_tilde_v() Exception thrown when 

evaluating vertical profile function. 

This indicates a problem with the numerical solution.  Please check input 
data.  If the problem persists contact DRIFT support. 

DRIFTVerticalProfile::H_tilde: The profile index 's' is 

equal to zero. 

This indicates a problem with the numerical solution.  Please check input 
data.  If the problem persists contact DRIFT support. 

ExpandedGasousJetSource::ExpandedGaseousJetSource() 

ratioOfSpecificHeats=1 

Please check the vapour heat capacity data and units for the released 
substance.  

For the given inputs the atmospheric boundary layer is 

predicted to be a pure Intermittency Layer. The physics of 

this regime is not well-understood and so DRIFT will 

instead assume that the cloud remains within the surface 

layer for the duration of this run. If this is problematic, 

try either reducing the mixing height or selecting a less 

stable atmosphere. 

A warning message indicating that the atmospheric conditions in this very 
stable regime where there is no reliable model - dispersion in surface layer 
conditions is assumed. 

GaspData::GaspData: Unable to load Gasp run. Please check the location of the GASP file and that this is a valid Gasp 4.0 
run, if necessary by re-running Gasp Version 4 and resaving. 

HydrogenFluorideMixture::initialise: No solution could be Problem initialising a hydrogen fluoride-water mixture.  Please check input 
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Warning Message Additional Explanation/Guidance 
found data.  If the problem persists contact DRIFT support. 
No solution could be found to the flashing equations. 

 

No solution to the flashing equations could be found. Run 

terminated. 

This indicates a problem in finding a solution to the flashing equations for the 
release.  Please check input data.  If the problem persists contact DRIFT 
support. 

Obstacle related messages: 

 

Low area momentum source in near wake obstacle of editing 

source accordingly. 

 

Britter criteria violated for obstacle. Terminating 

calculation.  

 

Ignoring obstacle for upstream calculation: source is not 

in near wake. 

 

Ignoring upstream obstacle: only taken into account for a 

low momentum area source. 

 

Ignoring obstacle for upstream calculation: only taken into 

account for a low momentum area source. 

 

Source is too close to obstacle and just upstream of it. 

Terminating calculation. 

 

Ignoring obstacle for timevarying model. 

 

Information messages relating to building and fence obstacles. More 
information about the obstacles model and the Britter Criteria can be found 
in section IVa of the FLADIS report (“Complex Features in Dense Gas 
Dispersion Modelling”, D.M. Webber, December 1994, AEA contract 
research report). 
 
 
 

Pasquill Stability x is unlikely to occur for wind speeds > 

y m/s 

 

A warning message indicating that the input Pasquill stability class is unlikely 
to occur with such a high wind speed.  Please check your input data. 

Plume velocity is zero. Terminating run. Check input release rate is not  zero and that rainout is less than 100%.  If 
the problem persists contact DRIFT support. 

Run terminated after xx s  / xx m. 

 

Maximum computing time exceeded. 

Information on the reasons that the model run terminated. 
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Warning Message Additional Explanation/Guidance 
Specified maximum downstream distance exceeded. 

Specified maximum plume width exceeded. 

Specified maximum cloud time exceeded. 

Specified minimum concentration level reached. 

Dilution factor has dropped below specified value. 

 

Steady source window established after xx s.  Proceeding to 

run continuous model. 

Information message when calculating dilution over a low momentum area 
source. 

Strata::getAtmosphericLayer: Error. Height is negative. This message indicates that the model is attempting to determine conditions 
outside the atmospheric boundary layer.  Please check input data.  If the 
problem persists contact DRIFT support. 

SubstanceDataSourceSPI::substance() No entry found for  

 

Antoine coefficients 

boiling point 

critical pressure 

critical temperature 

enthalphy of vaporisation 

flammability 

liquid density 

liquid specific heat 

molecular weight 

vapour specific heat 

 

Incomplete flammability information 

 

Indicates missing substance property data from the substance SPI file 
 
 
 
 
 
 
 
 
 
 
 
 
Upper and lower flammability limits must be entered if the substance is 
specified as being flammable 
 

SubstanceMixture::calcRatioOfSpecificHeats. Cv=0.0 Check the vapour heat capacity data and units for the released substance. 
SubstancePropertiesDB: Unable to find substance of this 

name. 

Check that the correct path is entered for the ESRSubstance and where 
applicable SPI file data sources.  See Section 2.2. 

The cloud centroid is initially within the xxxx Layer This message is for information only – indicating that the cloud centroid is so 
elevated that it is initially within the named layer of the atmosphere.  No 
message is given if the cloud centroid is in the surface layer (lowest layer of 
atmosphere).  Please check that the input source elevation and the 
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Warning Message Additional Explanation/Guidance 
predicted initial cloud height are both reasonable for your scenario. 

The file is not a DRIFT file. This message results from attempting read a file that is not a DRIFT file. 
The file is not a DRIFT version xxxx file . The DRIFT file version being read is not compatible with this version of 

DRIFT.  
The initial cloud height is predicted to be higher than the 

atmospheric boundary layer. 

The initial height of the cloud is predicted to be above the atmospheric 
boundary layer.  DRIFT only models dispersion within the atmospheric 
boundary layer.  Please check that the input source elevation and the 
predicted initial cloud height are both reasonable for your scenario. 

The initial release is predicted to contain a pure liquid 

phase. Run terminated. 

This message is issued when the release is predicted to be completely in 
the liquid phase and an instantaneous release is being modelled.  This may 
occur if the release is a sub-cooled liquid.  Due to relatively inefficient sub-
cooled liquid break-up, DRIFT’s instantaneous model is considered to be 
inappropriate for such releases and no run is performed. 

The initial release is predicted to be all liquid. Mixing 

in the minimal amount of air necessary to run. 

This message is issued when the release is predicted to be completely in 
the liquid phase and a continuous release is being modelled.  This may 
occur if the release is a sub-cooled liquid.  DRIFT will model the release as a 
finely atomised spray/mist.  All the liquid that is not rained out immediately at 
the source (see Section 3.2.7) is assumed to remain airborne unless the 
liquid deposition is specified (see Section 3.8).   The user should ensure that 
the release conditions are commensurate with the formation fine drops/mist 
– usually this would mean high pressure and small orifice dimension. 
A minimal amount of air is initially mixed into an all liquid release to allow 
DRIFT to run – this initial amount of air is so small it has no effect on 
predicted concentrations. 

The input radius is unphysical. The cloud will be assumed 

to have a unit aspect ratio. 

This indicates a problem with the input radius being too small for the 
instantaneous release.  In this circumstance DRIFT will calculate the radius 
based on a unit aspect ratio (radius=height) cloud. 

The source location is above the atmospheric boundary 

layer. Setting the height to be the mixing height. 

The specified source height is above the atmospheric boundary layer (the 
inversion height).  In this circumstance DRIFT assumes that the height is at 
the mixing height (equal to the inversion height).  Please check the input 
data - in particular the source height and inversion height.  

ToxicConcentrationField::convertFromToxicSubstanceCriteria. 

Cannot find substance. 

No substance is found from which to extract toxic criteria.  Please check that 
toxicity data has been entered for all toxic substances and that the 
substance property data source directories are correctly set (see Section 
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Warning Message Additional Explanation/Guidance 
2.2) 

Unable to run model.  

 

Cloud radius is less than or equal to zero. 

Cloud mass is less than or equal to zero. 

Composition Data not set. 

Contaminant not set. 

Contaminant mass fraction is less than or equal to zero. 

Contaminant mass fraction is greater than unity. 

Duration is less than or equal to zero 

Exit Data not set 

Flammable Target Data not set 

Input Data not set. 

Liquid fraction greater than unity. 

Liquid fraction less than zero. 

Mixture Data not set 

Mixture information not set. 

One or more of the source radii is less than or equal to 

zero. 

Preferences not set 

Pressure less than or equal to zero. 

Rainout fraction exceeds unity. 

Rainout fraction less than zero. 

Release profile not set 

Release rate is less than or equal to zero 

Release rate negative. 

Release rate profile has a negative time entry. 

Release rate profile has been input in the wrong order. 

Source Data not set 

The orifice radius is less than or equal to zero. 

Temperature is less than or equal to absolute zero. 

Termination Criteria not set 

Toxic Target Data not set 

Weather Data not set 

Messages indicating reasons why DRIFT is unable to run the model. 

Zero mass release: terminating calculation A zero mass release is predicted.  Please check the input data, in particular 



 67 

Warning Message Additional Explanation/Guidance 
the release mass, release rate, release duration and rainout fractions. 
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A1.1 Axis Variables – Continuous Release 

Axis Variable (Units) Description 

Ambient Density (kg/m3) Ambient air density at the height corresponding to cloud 
centroid height Z 

Ambient Pressure (Pa) Ambient pressure at the height corresponding to cloud 
centroid height Z 

Ambient Temperature (K) Ambient temperature at the height corresponding to 
cloud centroid height Z 

Ambient Vertical 
Diffusivity (m2/s) 

Ambient vertical diffusivity at the height corresponding 
to cloud centroid height Z 

Ambient Wind Speed 
(m/s) 

Ambient wind speed at the height corresponding to 
cloud centroid height Z 

Cloud Bulk Speed (m/s) Speed of the cloud averaged over the plume cross-
section 

Cloud Centreline Velocity 
X (m/s) 

X-component of the cloud centreline velocity 

Cloud Centreline Velocity 
Y (m/s) 

Y-component of the cloud centreline velocity 

Cloud Centreline Velocity 
Z (m/s) 

Z-component of the cloud centreline velocity 

Cloud Centroid X (m) X coordinate of the cloud centroid, defined as the mean 
height computed from the vertical concentration profile.  

Cloud Centroid Y (m) Y coordinate of the cloud centroid, defined as the mean 
height computed from the vertical concentration profile. 

Cloud Centroid Z (m) Z coordinate of the cloud centroid, defined as the mean 
height computed from the vertical concentration profile. 
This differs from Cloud Location Z when grounded but 
will be the same as Cloud Location Z in the limit of a 
fully elevated cloud.  

Cloud Density (kg/m3) The cloud density corresponding to the centreline 
concentration  

Cloud Dimensionless 
Meander Parameter, 
kappa 

Parameter  in the vertical meander model  

Cloud End Cap Profile 
Parameter aEndCap (m) 

Length-scale a for the end-cap of the cloud (used in the 
finite duration model) 

Cloud Excess Centreline 
Velocity X (m/s) 

X-component of the vector difference between the 
plume velocity and the undisturbed ambient velocity 

Cloud Excess Centreline 
Velocity Y (m/s) 

Y-component of the vector difference between the 
plume velocity and the undisturbed ambient velocity 

Cloud Excess Centreline 
Velocity Z (m/s) 

Z-component of the vector difference between the 
plume velocity and the undisturbed ambient velocity 

Cloud HF Monomer 
Vapour Fraction 

The HF monomer vapour fraction, xM 

Cloud Half Width (m) The cloud integral half-width, W                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                              

Cloud Height (m) The cloud integral height, H  

Cloud Lengthscale 
Omega (m) 

Parameter used in the spreading model related to the 
half-width. 

Cloud Lengthscale 
Omicron (m) 

Parameter used in the spreading model related to the 
end-cap width. 

Cloud Location X (m) X location of the cloud 

Cloud Location Y (m) Y location of the cloud 
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Axis Variable (Units) Description 

Cloud Location Z (m) Z location of the cloud (zero for a ground-based cloud) 

Cloud Maximum 
Concentration Distance 
(m) 

Curvilinear distance along the locus of the maximum 
concentration  

Cloud Maximum 
Concentration Locus X 
(m) 

X coordinate of the locus of the maximum concentration 
(used for contouring). 

Cloud Maximum 
Concentration Locus Y 
(m) 

Y coordinate of the locus of the maximum concentration 
(used for contouring) 

Cloud Maximum 
Concentration Locus Z 
(m) 

Z coordinate of the locus of the maximum concentration 
(used for contouring) 

Cloud Maximum 
Concentration Planar 
Distance (m) 

Curvilinear distance along the locus of the maximum 
concentration projected onto the horizontal plane 

Cloud Meander 
Parameter, chi_w (m2s) 

w  in the cloud vertical meander model 

Cloud Mixing Height 
Contact Ratio (f_h) 

A measure of the amount of contact between the cloud 

and the top of the mixing layer. 0=hf corresponds to 

no contact, 1=hf  corresponds to full contact. 

Cloud Molar Enthalpy 
Difference (J/mol) 

The molar enthalpy difference of the cloud mixture at 
the cloud temperature and pressure.  The difference is 
relative to a standard reference temperature and 
pressure. 

Cloud Molar Volume (m3) The molar volume of the cloud mixture at the cloud 
temperature and pressure 

Cloud Profile Factor 
Integral 1 

The profile integral nI  with n = 1 

Cloud Profile Factor 
Integral 2 

The profile integral nI  with n = 2 

Cloud Profile Factor 
Integral 3 

The profile integral nI  with n = 3 

Cloud Profile Lengthscale 
a (m) 

Length scale parameter a used in concentration 

profile F  

Cloud Profile Lengthscale 
b (m) 

Length scale parameter b used in horizontal 

concentration profile, hF  

Cloud Profile Parameter 
f_g 

Ground based to elevated cloud interpolation function, 

1=gf corresponds to a fully grounded cloud, 0=gf  

corresponds to a fully elevated cloud 

Cloud Profile Parameter s The vertical profile parameter s  

Cloud Profile Parameter w The horizontal profile parameter w  

Cloud Profile Parameter 
w_g 

The ground based horizontal profile parameter gw  

Cloud Profile Sigma Y (m) The standard deviation of the horizontal concentration 
profile (before the effects of time-averaging/lateral 
meander are applied). 

Cloud Profile Sigma Y 
(incl. lateral meander) (m) 

The standard deviation of the horizontal concentration 
profile (after the effects of time-averaging/lateral 
meander are applied). 
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Axis Variable (Units) Description 

Cloud Relative Density 
Difference (rho/rho_a-1) 

The relative density difference between the cloud and 

the surrounding air, 
a

a



 −
='  where   is the cloud 

density and a  is the air density 

Cloud Relative 
Temperature (T/Tref-1) 

The relative temperature difference between the cloud 
and the surrounding air 

Cloud Richardson 
Number, Ri* 

The Richardson number for the cloud defined by 

2

*

*

'

u

Hg
Ri


=  

where g  is the acceleration due to gravity, '  is the 

cloud relative density difference and *u is the friction 

velocity which is a characteristic turbulent velocity scale 
in the atmosphere. 

Cloud Stagnation 
Temperature (K) 

The cloud stagnation temperature corresponding to the 
centreline concentration  

Cloud Tangent Of Lean 
Over Angle 

The tangent of the angle that the cloud centroid axis 

makes with the vertical,   

Cloud Temperature (K) The cloud temperature corresponding to the centreline 
concentration  

Cloud Tilt Parameter The cloud tilt parameter 

Cloud Total Liquid Molar 
Flux (mol/s) 

The cloud total liquid molar flux passing through the 
cloud cross-section 

Cloud Total Mass Flux 
(kg/s)  

The cloud total mass flux passing through the cloud 
cross-section 

Cloud Total Molar Flux 
(mol/s) 

The cloud total molar flux passing through the cloud 
cross-section 

Cloud Trajectory Angle To 
Horizontal (rad) 

The angle the cloud trajectory makes with the horizontal 

Cloud Travel Distance (m) The curvilinear travel distance along the cloud centreline 
trajectory 

Cloud Travel Time (s) The travel time corresponding to the curvilinear travel 
distance along the cloud centreline trajectory 

Cloud Vapour Fraction The overall vapour mole fraction of the cloud mixture 

Cloud Vertical Meander 
Time (s) 

The characteristic time t used in the vertical meander 

model 

Component Liquid Molar 
Flux (mol/s) 

The liquid molar flux for each substance component of 
the cloud 

Drop Radius (m) The mean drop size radius for each distinct liquid phase 

Liquid Fraction The liquid moles for each distinct liquid phase as a 
fraction of the total moles 

Liquid Molar Flux (mol/s) The molar flux of each distinct liquid phase liquid phase 
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Axis Variable (Units) Description 

Liquid Mole Fraction Liquid mole fraction, ix  for each component substance 

in the cloud 

tL

iL

ix



=  where iL  is the liquid molar flux of 

component i and tL  is the total liquid molar flux 

Molar Flux (mol/s) Molar flux (irrespective of phase) of each component 
substance in the cloud 

Mole Fraction Mole fraction (irrespective phase) of each component 
substance in the cloud 

Number Flux of Drops (/s) Number of drops of each distinct liquid phase that pass 
through the cloud cross-section per second 

Phase Balance The phase balance of a component is defined by 

PPxy iiii /−  

where iy  is the vapour mole fraction of component i, ix  

is the liquid mole fraction,  iP  is the pure substance 

vapour pressure and i  is the activity coefficient in the 

liquid mixture 

Pure Vapour Pressure 
(Pa) 

The pure substance vapour pressure iP  of each 

component 

Vapour Molar Flux (mol/s) Molar flux of substance in the vapour phase iv  

Vapour Mole Fraction Vapour mole fraction, iy  for each component substance 

in the cloud 

tv

iv

iy



=  where iv  is the vapour molar flux of 

component i and tv  is the total vapour molar flux 
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A1.2 Axis Variables – Instantaneous Release 

Axis Variable (Units) Description 

Ambient Pressure (Pa) Ambient pressure at the height corresponding to the 
plume centroid coordinate at time t 

Ambient Temperature (K) Ambient temperature at the height corresponding to the 
plume centroid coordinate at time t 

Cloud Centroid X (m) X coordinate of the cloud centroid, defined as the mean 
height computed from the vertical concentration profile.  

Cloud Centroid Y (m) Y coordinate of the cloud centroid, defined as the mean 
height computed from the vertical concentration profile. 

Cloud Centroid Z (m) Z coordinate of the cloud centroid, defined as the mean 
height computed from the vertical concentration profile. 
This differs from Cloud Location Z when grounded but 
will be the same as Cloud Location Z in the limit of a 
fully elevated cloud.  

Cloud Density (kg/m3) The cloud density corresponding to the centreline 
concentration 

Cloud Excess Velocity X 
(m/s) 

X-component of the vector difference between the 
centroid velocity and the undisturbed ambient velocity 

Cloud Excess Velocity Y 
(m/s) 

Y-component of the vector difference between the 
centroid velocity and the undisturbed ambient velocity 

Cloud Excess Velocity Z 
(m/s) 

Z-component of the vector difference between the 
centroid velocity and the undisturbed ambient velocity 

Cloud HF Monomer 
Vapour Fraction 

The HF monomer vapour fraction, xM 

Cloud Height (m) The cloud height, H  

Cloud Lengthscale 
Lambda Crosswind (m) 

Integral length scale 2  

Cloud Lengthscale 
Lambda Downwind (m) 

Integral length scale 1  

Cloud Maximum 
Concentration Locus 
Distance (m) 

Curvilinear distance along the locus of the maximum 
concentration  

Cloud Maximum 
Concentration Locus X 
(m) 

X coordinate of the locus of the maximum concentration 
(used for contouring) 

Cloud Maximum 
Concentration Locus Y 
(m) 

Y coordinate of the locus of the maximum concentration 
(used for contouring) 

Cloud Maximum 
Concentration Locus Z 
(m) 

Z coordinate of the locus of the maximum concentration 
(used for contouring) 

Cloud Molar Enthalpy 
Difference (J/mol) 

The molar enthalpy difference of the cloud mixture at 
the cloud temperature and pressure.  The difference is 
relative to a standard reference temperature and 
pressure. 

Cloud Molar Volume (m3) The molar volume of the cloud mixture at the cloud 
temperature and pressure 

Cloud Profile Lengthscale 
a_1 (m) 

Cloud profile longitudinal length scale 1a  
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Axis Variable (Units) Description 

Cloud Profile Lengthscale 
a_2 (m) 

Cloud profile lateral length scale 2a  

Cloud Profile Lengthscale 
a_3 (m) 

Cloud profile vertical length scale 3a  

Cloud Profile Parameter 
f_g 

Ground based to elevated cloud interpolation function, 

1=gf corresponds to a fully grounded cloud, 0=gf  

corresponds to a fully elevated cloud 

Cloud Profile Parameter s The vertical profile parameter s  

Cloud Profile Parameter w The horizontal profile parameter w  

Cloud Profile Parameter 
w_g 

The ground based horizontal profile parameter gw  

Cloud Profile Sigma Y (m) The standard deviation of the horizontal concentration 
profile 

Cloud Relative Density 
Difference (rho/rho_a-1) 

The relative density difference between the cloud and 

the surrounding air, 
a

a



 −
='  where   is the cloud 

density and a  is the air density 

Cloud Relative 
Temperature (T/Tref-1) 

The relative temperature difference between the cloud 
and the surrounding air 

Cloud Richardson 
Number, Ri* 

The Richardson number for the cloud defined by 

2

*

*

'

u

Hg
Ri


=  

where g  is the acceleration due to gravity, '  is the 

cloud relative density difference and *u is the friction 

velocity which is a characteristic turbulent velocity scale 
in the atmosphere. 

Cloud Stagnation 
Temperature (K) 

The cloud stgnation temperature corresponding to the 
centreline concentration  

Cloud Tangent Of Lean 
Over Angle 

The tangent of the angle that the cloud centroid axis 

makes with the vertical,   

Cloud Temperature (K) The cloud temperature corresponding to the centreline 
concentration  

Cloud Tilt Parameter The cloud tilt parameter 

Cloud Total Mass (kg) Total mass of the cloud 

Cloud Total Number of 
Liquid Moles 

Total number of liquid moles in the cloud 

Cloud Total Number of 
Moles 

Total number of moles in the cloud 

Cloud Travel Distance (m) Curvilinear distance of travel of cloud centroid 

Cloud Travel Time (s) The travel time corresponding to the plume centroid 

Cloud Vapour Fraction The vapour fraction of the cloud 

Cloud Velocity X (m/s) X-component of the cloud centreline velocity 

Cloud Velocity Y (m/s) Y-component of the cloud centreline velocity 

Cloud Velocity Z (m/s) Z-component of the cloud centreline velocity 

Cloud Location X (m) X location of the cloud 

Cloud Location Y (m) Y location of the cloud 

Cloud Location Z (m) Z location of the cloud (zero for a ground-based cloud) 
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Axis Variable (Units) Description 

Component Liquid Moles The liquid molar flux for each substance component of 
the cloud 

Drop Radius (m) The mean drop size radius for each distinct liquid phase 

Liquid Fraction The liquid moles for each distinct liquid phase as a 
fraction of the total moles 

Liquid Mole Fraction The molar flux of each distinct liquid phase liquid phase 

Liquid Moles Liquid mole fraction, ix  for each component substance 

in the cloud 

tL

iL

i
N

N
x =  where iLN  is the liquid moles flux of 

component i and tLN  is the total liquid moles 

Mass Fraction Mass fraction (irrespective of phase) of each component 
substance in the cloud 

Mole Fraction Mole fraction (irrespective phase) of each component 
substance in the cloud 

Number of Drops Number of drops of each distinct liquid phase 

Number of Moles Number of moles of each substance component 

 


